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Chapter 1 Welcome
Home > Welcome

Welcome

HSTouch

Online Help
Welcome to the HSTouch for HS3 online help system. Browse through the help
pages by clicking on the icons below or selecting pages in the table of contents
to the left. To quickly find specific product information, enter search criteria in the
search box above and click the search button.

Getting Started

Working with
Projects

Dynamic Screens

Advanced
Functions

Designer Properties

Credits

Tutorials

If you're unable to find
what you're looking for
in this help system, try
these alternative
resources:
Our Website
Knowledgebase
FAQ

Mobile Clients

or contact our support
team:
Email:
Phone: 603‐471‐2816

Most popular pages
Welcome
Getting Started
System Requirements
Tutorials
Installation
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Energy
Overview
Advanced Functions
Working with Elements
Lighting Control

See also
Getting Started
Working with Projects
Tutorials
Dynamic Screens
Advanced Functions
Mobile Clients
Designer Properties
Credits
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Home > Getting Started

Getting Started
Articles in this section

Overview

System
Requirements

Installation

Setup for Designer
and Client
Designer Overview

Updates

Sample
Configurations

See also
Welcome
Working with Projects
Tutorials
Dynamic Screens
Advanced Functions
Mobile Clients
Designer Properties
Credits

Home > Getting Started > Overview

Overview
This help file is for use with the HS3 version of HSTouch.
HSTouch™ is an advanced graphical user interface ﴾GUI﴿ system for HomeSeer home automation software and
controllers. It is comprised of a Windows‐based "designer" program, a run‐time "client" for Windows, WinCE

HSTouch

3

Chapter 2 Getting Started

devices, iPhone/iPod Touch/iPad, Android and a "plug‐in" to integrate the designer and client﴾s﴿ with any HomeSeer
HS3 system. Projects are created with the designer and then deployed to the client﴾s﴿ for use.

Typical Configuration

See also
System Requirements
Installation
Setup for Designer and Client
Designer Overview
Updates
Sample Configurations

Home > Getting Started > System Requirements

System Requirements
This help file is for HSTouch version 3.0.0.0 and later and the HSTouch plug‐in version
3.0.0.15 and later. This guide is also for use with iPhone/iPod/iPad client version 2.16 or later
and the Android client version 1.49 or later.
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To run HSTouch, you'll need the following:

1. One of these HomeSeer home automation systems
Windows PC running HS3™ software
Windows PC running HS3PRO™software
HomeTroller™ controller ﴾any model, including Zee﴿
PRO‐100™ controller
2. A Windows PC to run the HSTouch designer on. Note: this may be same PC that runs HS3 or HS3 PRO.
3. A Windows‐based device to run the client on. This may be a PC, touchscreen, cellphone or other device
running Windows. Note: again, this may be the same PC that runs HS3 or HS3 PRO.
4. A iPhone or iPod Touch/iPad and the iPhone client from the Apple App Store. The app is free in the store.
The clients will connect to the standard version of HS3 as well as all the HomeTroller systems such as the
Zee, or any HomeTroller running HS3. A PRO version is not required.
5. An Android device such as an Android phone or Android tablet. The HSTouch client may be installed from
the Android Market, or installed manually from the downloads page at homeseer.com or the Android forum
at forums.homeseer.com. Only Android OS version 2.1 or later is supported. The app is also available in the
Amazon market and Kindle Fire app store.

PC requirements

For HS3 or HS3 PRO, and HSTouch designer and Windows client software:
Windows PC running Windows XP, Vista, Windows 7, or Windows 8
800 MHz ﴾or better﴿ CPU
1GB ﴾or better﴿ RAM
4GB ﴾or better﴿ hard drive
Network Connection
Sound Card

For Linux, a beta version of the client is available in the clients folder where the HSTouch Designer is
installed.
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See also
Overview
Installation
Setup for Designer and Client
Designer Overview
Updates
Sample Configurations

Home > Getting Started > Installation

Installation
Step 1: Download and install HomeSeer system software ﴾HS3 or HS3 PRO﴿ from this link:
http://www.homeseer.com/downloads/index.htm
Note: Current HomeSeer software and HomeTroller/PRO‐100 users may skip this step if they already have HS3
installed.

Step 2: Download HSTouch software from this link: http://www.homeseer.com/downloads/index.htm. Download
both the Designer and the plug‐in.

Step 3: Go to the Plugins page in HomeSeer and make sure the HSTouch Server plugin is installed and enabled.
This one plugin supports all HSTouch client types ﴾Windows/IOS/Android﴿.

Step 5: Use the HSTouch Designer installer to install the HSTouch designer onto any stand‐alone PC that can
connect to your HomeSeer system PC ﴾via LAN or WAN﴿. Or, you may install the designer onto your HomeSeer
system PC or HomeTroller.

Step 6: Locate the HSTouch run‐time client files and manually copy them to your HSTouch clients. The client files
are installed into the directory C:\Program Files\HomeSeer\HSTouch\clients by default and are named
HSTouch.exe ﴾Windows client﴿. For the iPhone/iPod Touch, install the HSTouch client from the Apple
App store.

Step 7: ﴾if you only want to use the default configuration that is installed on your device, and do
not wish to use the Designer, skip to step 8 now﴿ To test your installation, open a sample configuration from
the Designer, then select the Tools menu, then Deploy. If you have a client running and connected to HomeSeer,
you will see the IP address and name of the client in the Deploy menu. Select the Deploy Project File option as well
HSTouch
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as Include all Graphics and Sounds and Activate Project after Deploy. Click OK to deploy this project to your client
and activate. Check the client and make sure the new project is loaded.

Step 8: After you have the client installed on your device, a default configuration will be loaded when the HSTouch
application is run. The default configuration should be good enough to control most of your devices and events. By
default, the client will attempt to connect to our demo server at demo.homeseer.com. Try this connection first. If it
connects ok, you can then change the connection to connect to your HomeSeer system. Here are the instuctions
to change the client connections:

For Windows users: Right click in the upper right corner of the HSTouch screen. This will bring up a menu,
select Client Options and set the IP address of your HomeSeer system. If your HSTouch client is running on
your local LAN, then you will enter the local IP address that normally begins with 192. If you are running the
HSTouch client on the same PC as HomeSeer, you can enter localhost for the IP address. Here is the client
connection dialog:
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For iPhone/iPod Touch/iPad users, click your home screen then click the Settings icon. Look for the HSTouch
settings and set the IP address under one of the Server options ﴾1,2, or 3﴿.
For Android clients, click on your menu button, then select Settings. Enter the IP address of your HomeSeer
system. If you are using the MyHomeSeer service, select this as your connection and it will connect
automatically.
NOTE: On all clients, do NOT change the default port setting of 10200!

Step 9: When setting your HSTouch client to connect to HomeSeer, you need to enter the correct IP address. The
clients have options for up to 4 different servers plug My HomeSeer. For easy connections, select My HomeSeer
and make sure you have My HomeSeer enabled in HS3 ﴾Setup‐>Network﴿, and create an account at
http://myhs.homeseer.com.

If you are using the Designer, here are some notes related to the Designer:

Note that an update to the client files ﴾the XML project file﴿ may be 'deployed' from the designer to the clients via
LAN or WAN connection.

Deploying the client is only supported to CE clients ﴾this is the actual EXE client program file﴿. To update a Windows
client, copy the HSTouch.exe file from the clients folder to your Windows system, or run the setup.exe installer. To
update the iPhone/iPod/iPad client, get the latest from the Apple App Store. There are 2 clients in the store, one for
the iPhone/iPod and one for the iPad. These may be combined into a single universal app in the future.
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See the Updates topic for more information about HSTouch clients.

See also
Overview
System Requirements
Setup for Designer and Client
Designer Overview
Updates
Sample Configurations

Home > Getting Started > Setup for Designer and Client

Setup for Designer and Client
Before you can begin creating a project, you'll need to establish default settings for the designer and client﴾s﴿.
These options may be accessed from within the designer as shown below. IMPORTANT: These settings must
be correct and your HomeSeer system must be running to use the designer!

Designer Defaults
Tools > Options > Designer Defaults
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Open Last Project: Check this box to open the most recent project when the designer starts up.

Check for Updates: Check this box to have the designer check for software updates when it starts up.

Activate Project when Deployed: Check this box to activate the project as soon as it's deployed.

Choose Menu Location: The 'Control Menu Location' refers to the location and size of a hot‐spot on the client
screen from which the 'client options' menu may be accessed.

Menu Active Area Size: Use this option to change the size of the Menu Location hot‐spot described above.

Choose Graphics Root: Use this option to select a location for your graphics files. The default location is set by
the installer.

Note: The default settings for this window are typically fine for most users.

Connections Defaults
Tools > Options > Connection Defaults
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HomeSeer Name or IP Address: Enter your HomeSeer system's network name, IP address or MyHomeSeer‐
Connect address.

HomeSeer Port: This is the port number that the Designer or Client will use to connect to the HomeSeer server.
The default is 10200. The default port should be fine for most installations. If for some reason you need to use a
different port, enter a new port number here. You will also need to change the port number in the HSTouch plugin
in HomeSeer. To do this, go to your HomeSeer system, edit the file "hspi_HSTouch.ini" which is located in the
HomeSeer Config folder. Add the line: ﴾after [Settings]﴿

PortNumber=###

You will need to restart HomeSeer after making this change. Check the HomeSeer log and make sure the HSTouch
server starts on the new port number.

HomeSeer Username & Password: Enter your HomeSeer system username and password login.

Attention WAN Users: HSTouch operates on port 10200 and this setting is fixed. If you wish to use the designer
or clients remotely, you'll need to adjust your remote router to forward port 10200 to the HomeSeer system.

See also

HSTouch

11

Chapter 2 Getting Started

Overview
System Requirements
Installation
Designer Overview
Updates
Sample Configurations

Home > Getting Started > Designer Overview

Designer Overview
The HSTouch designer includes an integrated development environment ﴾IDE﴿ that consists of a Elements
Plalette, Devices Palette, Design Area and Properties Pane ﴾as shown below﴿.

Elements Palette
Graphics, text, and controls, including buttons, backgrounds, sliders and other elements are stored in the Elements
Palette. These elements may be added to any screen using a simple drag and drop operation.
HSTouch
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Devices Palette
The designer automatically imports HomeSeer devices to the Devices Palette. Devices may be added to any
screen using a simple drag and drop operation.

Design Area
Any and all screens may be displayed and edited in the Design Area. To select a screen, simply click on it or
choose it from the 'Screens' menu in the top menu bar.

Properties Pane
Properties for any element on any screen ﴾including the screen itself﴿ may be edited within the Properties Pane.
To edit any element, select it first by clicking on it or choosing it from the drop‐down menu at the top of the
Properties Pane. Once selected, properties for that element will appear in the pane. Click on the property you
wish to change and edit. Be sure to save the project when finished to save your changes.

Standard Menu Options
Standard Menu Options may be selected from pull‐down menus near the top of the designer.

File Menu

New Project: Use this menu option to create a new project.

New Screen: Use this menu option to create a new screen in the existing project.

Open Project: Use this option to open an existing project
HSTouch
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Save: Use this option to save the currently open project.

Save As: Use this option to save the currently open project with a new project name.

Save Selection as Custom Template: Use this option to save the currently selected elements as a custom
template.

Save Selection as Thermostat Template: Use this option to save the currently selected thermostat elements
as a thermostat template.

Save Selection as Mustic Template: Use this option to save the currently selected music elements as a music
template.

Exit: Use this option to exit the program.
‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐

Edit Menu

Undo: Use this option to undo the last operation. HSTouch supports an unlimited number of undo levels.

Redo: Use this option to recover from an undo operation.

Copy: Use this option to copy selected elements to the Windows clipboard.
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Paste: Use this option to paste the contents of the Windows clipboard.

Delete: Use this option to delete selected elements.

Select All: Use this option to select all elements in the design area of a screen.

Select All Screens: Use this option to select all screens in a project.
‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐

View Menu

Toolbar: Use this option to view or hide the toolbar.

Status Bar: Use this option to view or hide the status bar.

Elements: Use this option to view or hide the Elements Palette.

Devices: Use this option to view or hide the Devices Palette.

Grid: Use this option to view or hide the alignment grid.

Refresh: Use this option to refresh ﴾redraw﴿ the current screen.
‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐

Format Menu

HSTouch
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Align: Align selected controls on top, middle, bottom, left, center, right. Select multiple elements and then use
these options to align your elements.

Vertical Spacing: Use to evenly space selected elements vertically.

Horizontal Spacing: Use to evenly space selected elements horizontally.
‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐

Tools Menu

Connect At Startup: Use this option to connect to a HomeSeer system on startup. The designer Connection
Defaults settings will be used unless project Connection Information Override Settings are used.. r oject
connection

HSTouch

16

Chapter 2 Getting Started

Connection Control > Connect or Disconnect: Use this option to connect to or disconnect from a HomeSeer
system on startup.

Snap to Grid > Enabled: Use this option to enable the 'Snap to Grid' feature in the design area. When enabled,
elements will always snap to the closest grid market when moved by mouse.

Snap to Grid > Grid Size: Use this option to set the size of the grid. This setting is in pixels.

Options > Designer Defaults: Use this option to set the Designer Defaults.

Options > Grid Size: Use this option to set the Connection Defaults for the designer..

Options > Grid Size: Use this option to set the Project Defaults.
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Deploy > [client name]: Use this option to deploy a project to a client or to update the client application itself.
‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐

Screens Menu

Use this menu to select various screens in a project.
‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐

Help Menu

Contents: Use this option to view the contents of the HSTouch help file.

Index: Use this option to view HSTouch help file index.

About: Use this option to view information about HSTouch.

Special Keys:

Tab Key: Toggles view by hiding palettes

Dealing with views larger than the designer:

HSTouch
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There may be cases where you are designing a screen on a PC that has a monitor size of 800x600 but your design
is 768x1024. In this case, your screen may be "cut off" at the bottom. To see the entire screen, click and drag the
title bar of the window and drag the screen down about halfway down the screen. Now move your mouse pointer
to the top edge of this screen until the pointer changes to an arrow. You can now click and drag the border of the
screen up to it's full size.

See also
Overview
System Requirements
Installation
Setup for Designer and Client
Updates
Sample Configurations

Home > Getting Started > Updates

Updates
The designer includes an auto update feature. When the designer starts it will check for a new version of
the software automatically.

To update any Windows CE clients, the latest client is located in the Clients folder in the folder where you
installed the Designer software. By default this is:

C:\program files\HomeSeer HSTouch\Clients

In the clients folder there are folders for the CE client and the Windows client. For CE, copy all of the files in
this folder to the CE client. For Windows, you can simply copy the HSTouch.exe file to any Windows system.
Note that the Windows client is dependent on the .NET 2.0 framework so this needs to be installed on the
PC where you are running the client. If you don't have .NET 2.0 installed, you can run the setup.exe
installer and this will install the .NET framework for you. There are 2 CE clients, one for a generic CE device,
and one for PocketPC devices such as Windows Mobile SmartPhones. Use the client that works best for
your hardware.
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Linux/MacOSX Clients

A client for Linux and Mac OSX is available in the clients folder on the system where the designer is
installed. Note that these clients are still considered beta. The embedded browser control is not functional
in these clients.

See also
Overview
System Requirements
Installation
Setup for Designer and Client
Designer Overview
Sample Configurations

Home > Getting Started > Sample Configurations

Sample Configurations
One easy way to get started with HSTouch is to load one of the sample configurations that are included.
The samples have screens that are already created to display weather, thermostats, music control, lighting,
RSS News and Twitter data. The configurations below for the iPhone, iPad and Android are the ones that
are included with the application when it is installed from the App store or Android market.

If you are developing an iPhone configuration, open the sample named iPhone2.xml and for the iPad it is
iPad2.xml.

For Android, there are 2 default configurations, Android‐480x854.xml and Android‐480x800.xml. You can
open these in the designer and customize them as needed.

For Windows, you can use the Android or IOS samples as a start.
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After you complete the changes, select "Save As" from the File menu to save your configuration under a
new name.

To test the configuration select "Run Windows Client" from the Tools menu. This will run your new
configuration using the HSTouch Windows Client.

To send this configuration to another PC running the HSTouch client, select "Deploy" from the tools menu
and choose the client you want to deploy to.

See also
Overview
System Requirements
Installation
Setup for Designer and Client
Designer Overview
Updates
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Home > Working with Projects

Working with Projects
This opening paragraph should describe the feature that you are documenting. Explain how it is
commonly used and what the benefits are. For example: The Widget Master email link allows you to easily
send information about each widget to various departments within your company. Often, the feature that
you are documenting can be best explained by walking the reader through step by step. Use screenshots
to illustrate the steps where possible.
1. Start the application by…
2. On the startup screen, click the…
3.

See also
Welcome
Getting Started
Tutorials
Dynamic Screens
Advanced Functions
Mobile Clients
Designer Properties
Credits

Home > Working with Projects > Creating Projects

Creating Projects
A project includes the screen ﴾or screens﴿ created for use on one or more client devices. If all client devices are to
be identical in function, only one project needs to be created. If client devices are to be different from each other
in function, one project must be created for each client device.

To create a project, open the HSTouch designer and choose 'New Project' from the File menu.
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The 'Project Defaults' screen will now appear as shown below.

Screen Settings
Type: Use this menu to select your client device. This will automatically set the proper screen width and height. If
your client device does not appear in the menu, you'll need to set your dimensions manually. For an iPhone/iPod
project, select iPhone/iPod from the list, select iPad for the iPad device.
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Add a Title bar to all Screens: Check this box if you intend to run the HSTouch client in a separate application
window on your client PC.

Width: Enter the width ﴾in pixels﴿ of your client device.

Height: Enter the height ﴾in pixels﴿ of your client device.

Background: Use this menu to select the default background color or image for your project.

Return to the main screen after: If checked, the main screen will be displayed after the number of minutes
specified has elapsed. The main screen is the screen with the IsMain property set to TRUE.

Clear the stored passcode after: Enter the number of minutes that the system should keep any entered
passcode. Screens may be passcode protected and entering a number greater than 0 will force any entered
passcode to be forgotten after XX number of minutes. A value of 0 will disable the clearing of any saved passcode.

Max Image Width: The maximum size ﴾width﴿ for images that are obtained from the web or from a music plugin
such as iTunes album art. Album are can be quite large ﴾up to 2MB﴿. If you client is a CE device, the device could
hang for up to a minute while the image is being transferred. You can set limits here that will reduce significantly
the size of any image that is to be transferred. Set this value as well as the Max Image Height to 0 if you always
want to use the original image size. No resizing will take place if either value is set to 0.

Max Image Height: See MaxImageWidth. This parameter sets the maximum image height.

Misc Settings
Default Skin: Use this menu to select the skin ﴾or theme﴿ for your project. This will determine which background
and button images appear in your Elements Palette.

Project Name: Enter a name to identify the device you're designing this project for.

Notes: Use for notes regarding this project.

Orientation: On the iPhone/iPod/iPad rotation support is available, or a fixed orientation. Set to Both if rotation
support is desired. See the Appendix on iPhone support for more information on rotation.
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Scale Fonts: A scale factor can be added to scale all of the fonts in the project if the fonts on the target device are
not the correct size. Ons ome devices, the fonts may not appear exactly the same as in the designer. This setting
can normally be ignored.
Scale Screens to Fit Device: If checked, the screens will be resized to fit the size of the screen on the target
device. This setting is for Android clients only. The Android client also has this setting so it can be enabled in the
client if it is not enabled in the designer. If your project is targeting multiple devices, then keep this checked. If your
design is for a specific device and the design is created for the target screen size, then do not check this.
Graph Format: Sets the format for any graphs displayed in the project, this includes any energy graphs on the
energy viewer page. The format is:
back_color,pane_color,bar1_color,bar2_color,gradient_angle,font_color,pane_color_left,pane_color_bottom
bar1 is the bar color on a bar graph, and bar2 is the second color on graphs with 2 data points ﴾IE: today vs.
yesterday for energy﴿
gradient_angle is the angle of the gradient, set to 0 for no gradient and use a solid color.
The color format is HTML, and example is:
#0099FF,#33FFFF,#330099,#990000
This color pattern creates the following graph colors:

Connection Information Override Settings
IP Address, Username and Password: These fields are typically left blank since project connection settings are
already determined by the designer's Connection Defaults. Use these fields only when creating projects for other
HomeSeer systems ﴾such as a secondary residence or vacation home﴿. Note: the port setting for this connection is
fixed at port #10200.

Note: the Project Defaults screen may also be access from the 'Tools' menu:
Tools > Options > Project Defaults
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See also
Working with Graphics
Working with Elements
Working with Actions
Working with Music
Working with RSS Data
Working with Video
Working with the Web
Working with Device Screens
Working with Device Status

Home > Working with Projects > Working with Graphics

Working with Graphics
Standard Graphics
HSTouch includes a small library of pre‐designed backgrounds, buttons and other graphics to use when
creating screens. To use any of these graphics, open the Elements Palette and drag/drop them to your
design area ﴾as shown below﴿.

Custom Graphics
Custom projects often require the use of custom graphics and HSTouch works very nicely with a wide range
of custom graphics formats. To create custom graphics, you'll need an image editing program such as
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Photoshop, Paint Shop Pro, MS Paint, GIMP ﴾free﴿ or any just about any other image editor available.

Custom Graphics Formats Supported
B M P ‐ Bitmap graphics are images of very high quality with no file compression. This format is useful when
high quality images are required and filesize is not a concern. Transparency is not supported in this format.

GIF ‐ GIF graphics are images of varying quality that include file compression. This format is useful when
filesize is a concern. Transparency is supported to a limited degree and works best with simple shapes and
colors.

JPG ‐ JPG graphics are images of varying quality that include file compression. This format is useful when
filesize is a concern. Transparency is not supported in this format.

PNG‐8 ‐ PNG‐8 graphics are images of varying quality that include file compression. This format is useful
when filesize is a concern. Transparency is supported to a limited degree ﴾as with GIF images﴿ and works
best with simple shapes and colors.

PNG‐24 ‐ PNG‐24 graphics are images of high quality that include limited file compression. Alpha‐
blending transparency is supported. This format is useful when high quality transparent images are
required.

Naming Conventions File Locations for Graphics
When creating custom graphics for HSTouch, be sure to use the following naming conventions and saving locations
to ensure they behave correctly and appear in the Elements Palette.

Backgrounds ‐ Only 1 graphic is needed per background and there are no specific naming conventions to follow.
The default location to save 1024 x 768 pixel backgrounds would be:
C:\Program Files\HomeSeer\HSTouch\Skins\Default\Backgrounds\1024x768\

Graphic Buttons ‐ 2 graphics should be created for each button; one for the normal state of the button and one
for the pressed state. The filenames must follow this convention:
MyCustomButton‐norm.png ﴾normal state﴿
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MyCustomButton‐pressed.png ﴾pressed state﴿
The default location to save graphic buttons would be: C:\Program Files\HomeSeer\HSTouch\Skins\Default\Buttons\

Sliders ‐ 2 graphics should be created for each slider; one for the slider background one for the pointer image.
The filenames must follow this convention:
MyCustomSlider‐background.png ﴾slider background image﴿
MyCustomSlider‐button.png ﴾slider pointer image﴿
The default location to save sliders would be: C:\Program Files\HomeSeer\HSTouch\Skins\Default\Sliders\

Graphics ‐ Images and other graphic design elements may be saved to the 'Graphics' section of the Elements
Pane. There are no specific naming conventions to follow.
The default location to save graphics would be: C:\Program Files\HomeSeer\HSTouch\Skins\Default\Graphics\

Transparency
In Windows, all graphics are created and stored as square or rectangular objects with background and
foreground attributes. This is fine for projects that consist only of square or rectangular elements. However,
for projects that require rounded elements, you'll need to use graphics that support transparency ﴾see
Custom Graphics Formats Supported﴿.

The example below illustrates the importance of transparency when using rounded elements. Note that
BMP and JPG elements don't support transparency and appear as round buttons on square white
backgrounds. GIF elements support limited transparency but only where the background is a solid color.
The PNG‐24 format supports alpha‐blending and creates a very nice transparent effect. We recommend
using PNG‐24 graphics whenever transparency is required.
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Simulated Transparency
In order to use transparency, your HSTouch client hardware will need to support alpha‐blending. For most Windows
clients, this is not an issue. However, some Windows CE and Windows Mobile clients do not support alpha‐
blending. For those clients, you can still achieve a transparent effect with some creative background matching.

Step 1 ‐ In the image editor, open the background you intend to use for your project and place your button on top
of it in its correct position. Now draw a selection around it and save it to your HSTouch buttons folder as a BMP ﴾or
JPG﴿ element. This example shows a 90x90 pixel BMP element:

Step 2 ‐ In the HSTouch designer, open your project screen and drag/drop the new BMP element from the
Elements Palette to it's exact position ﴾as shown below﴿. As you can see, the button appears as a transparent image.

Note: You can achieve the same transparency effect with a bit more design flexibility by using a solid color
background and a graphic element with the same background color. The technique is commonly used by web
designers.

Missing Graphics
If your project is referencing graphics that are missing from the file system where the project is deployed, a
missing image graphic will be displayed. This graphic will help you locate any missing graphics that might otherwise
not be visible. In some cases, it may not be desirable to display the missing graphic image. One case might be
where you associated an element with a HomeSeer device and the device does not have graphics for each of its
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status's. In this case, you can stop the missing graphic image from displaying by deleting the file
"missing_image.bmp" which is located in the default\graphics folder of your skins folder. By default this is located in:
c:\my documents\HSTouch\skins\default\graphics\missing_image.bmp.

See also
Creating Projects
Working with Elements
Working with Actions
Working with Music
Working with RSS Data
Working with Video
Working with the Web
Working with Device Screens
Working with Device Status

Home > Working with Projects > Working with Elements

Working with Elements
All HSTouch screens include a collection of design and/or control objects called 'Elements'. HSTouch supports a
wide variety of element types including graphic buttons and backgrounds, sliders, images, list boxes, text objects
and custom groups. A complete list of element types may be found in the appendix.

Adding elements: To add an element to any screen, simply drag and drop the element from the Elements Palette
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to the screen.

Selecting elements: To select a single element, click on it with your mouse or choose it from the top menu on
the Properties Pane. To select a group of elements, hold down the control key and click each element or use the
mouse to draw a box around the elements.

Moving / Resizing elements: To move an element, click and drag the element to the desired location or select
it and use your keyboard arrow keys to move it. To resize an element, select it first and move the mouse cursor
over the bounding box for the element. When the double‐arrow cursor appears, click and drag to resize the
element. Element position and size may also be adjusted using the Properties Pane.

Copy / Paste elements: Elements may be copied and pasted to any screen in a project. This is useful for adding
elements like a 'main menu' button to each screen. To copy one or more elements, select them first and then
choose 'copy' from the 'edit' menu. Alternately, you can right‐click on your selected elements and choose paste
from the context menu that appears. Then, switch to the screen ﴾or location﴿ you wish to paste to and choose
'paste' from the edit menu or right‐click menu.

Deleting elements: To delete elements from any screen, select them first and choose 'delete' from the edit
menu or right‐click into your selection and choose 'delete' from the context menu that appears.

Editing element properties: To edit the properties of an element, select it first and then use the Properties
Pane to make your edits. A complete list of element properties may be found in the appendix.

Element Types
See Element Types in the appendix for a complete list of element types.

See also
Creating Projects
Working with Graphics
Working with Actions
Working with Music
Working with RSS Data
Working with Video
Working with the Web
Working with Device Screens
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Working with Device Status

Home > Working with Projects > Working with Actions

Working with Actions
Actions are specific commands that may be assigned to any control element in HSTouch using the properties in the
'Actions' section of the Properties Pane. A complete list of action types may be found in the appendix.

Example Action
The following example shows how to assign an action to a button that turns a lamp on and off.

Step 1 ‐ Drag/drop a button to the design area of a screen ﴾as shown below﴿. This will be your lamp button.

Step 2 ‐ Select the lamp button and open the settings for the 'ActionsWhenReleased' property on the Properties
Pane ﴾as shown below﴿:
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Step 3 ‐ At this point, the Action Editor will pop‐up ﴾as shown below﴿. Click 'Add' at the bottom of the 'Actions' list
to assign your first action to the lamp button. Then select the appropriate 'Action Type', 'Device' and 'Command'
from the drop‐down menus in the Settings area on the right. Note: You may add as many actions to this lamp
button as you like and you may change the sequence of the actions using the vertical arrows to the right of the
Actions list.

Step 4 ‐ When you're done editing actions for the lamp button, click 'OK'. You may now test the lamp button using
the HSTouch client.
‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐

Action Types
See Action Types in the appendix for a complete list of action types.
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See also
Creating Projects
Working with Graphics
Working with Elements
Working with Music
Working with RSS Data
Working with Video
Working with the Web
Working with Device Screens
Working with Device Status

Home > Working with Projects > Working with Music

Working with Music
HSTouch integrates tightly with the HomeSeer music API and provides a number of control elements for
music selection and player control. Here are a few commonly used music control elements.
Note: These features will only work with HomeSeer systems that include a music player plug‐in ﴾iTunes, Windows Media Player,
etc.﴿.

Music Selector Box
This control is designed to browse music libraries by genre, artist, album and track. To create a music selector box
for iTunes, follow these steps:

Step 1 ‐ Drag/drop a List Box element from the Others tab on the Elements Palette to your screen ﴾as shown
below﴿
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Step 2 ‐ Resize the list box to display the number of desired list items and adjust the properties for color and font
to suit your taste.

Step 3 ‐ Select the List Box by clicking on it and then open the Control Associations editor by click on the
'StatusTracking' property in the 'Status/Device Associations' section of the Properties Pane ﴾as shown below﴿
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Step 4 ‐ In the Control Associations editor, choose 'Music' from the 'Normal Association Type' menu and then
'iTunes Music Selector' from the 'Music' menu ﴾as shown below﴿.

Step 5 ‐ To control what the music selector displays, you'll In the Control Associations editor, choose 'Music' from
the 'Normal Association Type' menu and then 'iTunes Music Selector' from the 'Music' menu ﴾as shown below﴿.

Note: When you select a track to play, HSTouch then looks for a screen named "Now Playing". If this screen exists, it
will switch to that screen. You can use the Now Playing screen to display controls like Next, Previous, album
artwork, etc.

See also
Creating Projects
Working with Graphics
Working with Elements
Working with Actions
Working with RSS Data
Working with Video
Working with the Web
Working with Device Screens
Working with Device Status
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Home > Working with Projects > Working with RSS Data

Working with RSS Data
HSTouch may be configured to import RSS data feeds and display that data in a number of ways. This feature is
particularly useful when creating screens to display weather, news, sports and financial data from any source. The
following example shows how to add a text element to a screen and configure it to display the current outside
temperature using RSS data.

Step 1 ‐ Drag/drop a text element to the design area of a screen ﴾as shown below﴿. This text element will be
configured to display the RSS data.

Step 2 ‐ Select the text element and open the settings for the 'StatusTrackingNormal' property on the Properties
Pane ﴾as shown below﴿:

Step 3 ‐ At this point, the Control Associations window will open ﴾as shown below﴿. Since the text element is for
display only, check the box for 'Use the same for Normal/Pressed'. Now, open the Normal Association Type menu
and choose RSS Data. Then select the radio button for 'Use Status Text' at the right and click the 'Edit' button.
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Step 4 ‐ The next window to appear is the RSS Data Browser ﴾shown below﴿. Select 'Current Weather' from the
'Common RSS Feeds'.. Now, click the 'Get Data' button and use the arrow buttons near the right of the window to
advance the data to the 'temp' field. Click on the temperature data in the 'temp_F' field and then click OK to save
this setting.

NOTE: You have 2 default options for weather data, WeatherBug or World Weather Online. Regardless of which
one you choose you will need to obtain a weather API key ﴾free﴿ from either service. Also, you will need to enter
the API key in the HomeSeer HSTouch Server configuration settings ﴾from the HomeSeer Interfaces page in Setup﴿.
You can also simply add the API key to the URL in the designer in which case you do not need to add the API key
in HomeSeer. To enter the API key in the URL, replace [$WEATHERAPIKEY] with your API key.

HSTouch

38

Chapter 3 Working with Projects

At this point, the design area will once again appear and the text element will now display the current temperature
as show below.
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It is also possible to insert RSS data directly into a text element using the [$RSS] replacement variable. See the
Replacement Variables topic for more information.

See also
Creating Projects
Working with Graphics
Working with Elements
Working with Actions
Working with Music
Working with Video
Working with the Web
Working with Device Screens
Working with Device Status

Home > Working with Projects > Working with Video

Working with Video
Adding HomeSeer Security Camera Video To A
Custom HS3Touch Project
HSTouch may be easily configured to display video from network cameras. This feature is useful for creating
screens to monitor any area of your home. The following example shows how to add video from a HomeSeer
security camera to any HS3Touch screen.

Configuring The Video Element
1. Drag/drop an image element to any screen
2. In the Appearance section of the properties pane, enter and edit this URL into the ImageURLNormal
property:
http://admin:PASS@I P/mjpeg/snap.cgi?chn=1 ﴾ You'll need to change PASS and IP to your camera
password and IP address.﴿
Example: http://admin:pass123@192.168.1.40/mjpeg/snap.cgi?chn=1 ﴾where the camera password is
pass123 and the IP address is 192.168.1.40﴿
3. With the video image element selected, edit these properties:
IgnorePresses: True
ImageFormat: Stretched
Width: 640 ﴾or whatever you want﴿
Height: 360 ﴾or whatever you want﴿
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IsVideo: True ﴾this property updates the snapshot images﴿

The above settings yield the camera image shown below on a 800 x 450 screen.

Configuring Pan/Tilt Buttons
1.
2.
3.
4.

Drag/drop a button element to your video screen
With the button selected, click into the ActionsWhenPressed property to open the Action Editor.
In the Action Editor, Action Type Run a HomeSeer script with values..
add this script command: http://admin:PASS@IP/hy‐cgi/ptz.cgi?cmd=ptzctrl&act=right inserting
your camera's password and IP address. This script will cause the camera to pan right when the button is
pressed.
5. With the button selected, click into the ActionsWhenReleased property to open the Action Editor.
6. add this script command: http://admin:PASS@IP/hy‐cgi/ptz.cgi?cmd=ptzctrl&act=stop inserting
your camera's password and IP address. This script will cause the camera to stop panning when the button is
released.
Repeat the steps above for each pan/tilt button you wish to add to your project.
Here are the pan scripts:
Pan Right: http://USER:PASS@IP/hy‐cgi/ptz.cgi?cmd=ptzctrl&act=right
Pan Left: http://USER:PASS@IP/hy‐cgi/ptz.cgi?cmd=ptzctrl&act=left
Pan Up: http://USER:PASS@IP/hy‐cgi/ptz.cgi?cmd=ptzctrl&act=up
Pan Down: http://USER:PASS@IP/hy‐cgi/ptz.cgi?cmd=ptzctrl&act=down
Stop Pan: http://USER:PASS@IP/hy‐cgi/ptz.cgi?cmd=ptzctrl&act=stop
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See also
Creating Projects
Working with Graphics
Working with Elements
Working with Actions
Working with Music
Working with RSS Data
Working with the Web
Working with Device Screens
Working with Device Status

Home > Working with Projects > Working with the Web

Working with the Web
HSTouch may be easily configured to display web graphics and web pages from the internet. The following
example shows how to add web content to any HSTouch screen.

Step 1 ‐ Drag/drop an text element to the design area of a screen. Now select the text element and use the
Properties Pane to edit the following settings:

ACTIONS
Property
IgnorePresses

Setting
True

APPEARANCE
Text

http://www.homeseer.com

LOCATION/SIZE
Height

3 6 0 ﴾your dimensions may vary﴿

Width

4 8 0 ﴾your dimensions may vary﴿

Web
AllowNavigation

HSTouch

False

42

Chapter 3 Working with Projects

IsHTML

True

If you want to be able to navigate to other pages from this element, set the property "AllowNavigation" to TRUE. If
its set to false, only the page you entered in the Text property will be displayed. This property is not available on CE
clients.

Note: If you have an HTML page that does not specify a background color, you can use the "ColorNormal"
property to specify a background color for the HTML page. This is not available on CE clients.

The browser used to display the page is Internet Explorer, so you can display any page that IE can display. Note that
the CE client uses the Pocket IE browser which may not display all content. It does not support javascript.

The above settings yield the screen as seen below"
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See also
Creating Projects
Working with Graphics
Working with Elements
Working with Actions
Working with Music
Working with RSS Data
Working with Video
Working with Device Screens
Working with Device Status

Home > Working with Projects > Working with Device Screens

Working with Device Screens
Normally you create your screens in the designer and add elements as needed based on your HomeSeer
configuration. For example, you can add buttons to turn a specific device on or off. See some sample configurations
for some examples of how to create your own screens.

Screens may be create that can control multiple devices. This is done based on the device type of the device. For
example, on one screen you have a list that is set as a device browser. This list automatically allows you to browse
all of your devices. When you select a device, a simple screen is displayed to control it, and in the case of a
thermostat, no controls are available. If you create a dedicated control screen and set the DeviceTypes property to
the name of the device types that the screen will support, this screen will be displayed instead. For example, a
dedicated thermostat control screen can be displayed when you want to control a thermostat. To create this screen
do the following:

1. Add a new screen to your project
2. Add the desired elements to control the device you want to control. For example, if you want a control
screen to control a dimmable light, add an On and Off button, and a slider for dimming, name the slider
dimslider. Add associations and actions to control one of your existing devices. This is important as default
associations and actions must exist or the screen will not function. When the screen is displayed on the
client, the client will replace all associations and actions with the ones needed to control the desired device.
3. In the DeviceTypes property, list the device types you want this screen to control. To get the device types go
to your HomeSeer status screen and look at the Type column. If your lighting device is a Z‐Wave dimmable
device, the device type might be: Z‐Wave Switch Mulitlevel. Add this to the property. You can add as many
device types as you want, but they should all be similar.
4. The control screen can also have a label that displays the name of the device. Add a label element and
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name the element devicename. The client will replace the text property of this element with the name of the
device being controlled. If would like to display the location of the device, add 2 label elements, one should
be named devicelocation1 and the other devicelocation2. These two labels will be populated with the location
of the device.

Note that you can only control one device per screen as all elements on the screen will have their associations and
actions replaced with references to the new target device.

See the default configurations that are included for all platforms for an example of how to use these control
screens.

See also
Creating Projects
Working with Graphics
Working with Elements
Working with Actions
Working with Music
Working with RSS Data
Working with Video
Working with the Web
Working with Device Status

Home > Working with Projects > Working with Device Status

Working with Device Status
There may be times when you want to display the status of a HomeSeer device, and have HSTouch update that
status in real time. The most common use for this is to track the status of a light. However, you can track the status
of any HomeSeer device. You have 3 display options when displaying the status of a device:

1. Display the text status of the device such as ON, OFF, or DIM.
2. Display the image status of the device as its displayed in HomeSeer. HSTouch will automatically retrieve the
same image that HomeSeer is displaying for the device. This may not be an optimal image for HSTouch to
display, so if you select the image option, you can then associate your own images with each status.
3. Display the value of the device as text. If the device has a value associated with it, such as the temperature
or some other number, you can display this.
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Here is the procedure to display the default status image for a light:

1﴿ Drag a text element to your screen and click on the "StatusTrackingNormal" button, the Element Associations
dialog will display. Check the "Use the same for Normal/Pressed, select "HomeSeer Devices" for the Normal
Association Type, then select your light from the HomeSeer Devices drop list. The screen should look as follows:

If you select "Use Status Text", the current status of the device will be displayed as text, such as "On". If you select
"Use Status Image", you will see the image that HomeSeer uses for this device, for example:
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And finally, if you select "Use Value", you will get the value if the device, in this case the value is the Dim level:

Select "Use Status Image" then click OK to close the dialog.

Set the properties of your Text elelment as follows:

Setting

Property

APPEARANCE
ImageFormat

Normal

Text

﴾leave blank﴿

Status/Device Associations
Height

8 6 ﴾your dimensions may vary﴿

Width

150 ﴾your dimensions may vary﴿

Your Text element will now use the status of the HomeSeer device as its background image and will look like this:

You can set the NormalImage property to "Stretched" which will enlarge the graphic, bit the appearance will
probably not be desirable. To fix this, you can assign your own images to the various status's of the device. Click on
the "StatusImages" property to display the "Status Images Editor".
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Note that the Status Images properly will not be visible unless you have associated the element with a HomeSeer
device. Set the association first, then click on the "..." next to this property.

The Status Images Editor allows you to assign images to each status the device supports. Click on the Add button
to add a new image, then click on the Image property to select the image, then select the status you want to
associate. You can also associate values if you like. If you use values, you can specify a range like: 1‐99 so that a
single graphic can represent a range of values. This example shows a lamp ON image associated with the On
status:

The graphics folder contains lamp images for On, Off, and Dim. Add each image to each status then click OK to
save the changes. Your screen element will now use the new images as shown:
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When the status of this device changes in HomeSeer, the screen will automatically update with the proper graphic.

Se the ImageFormat propery of the elelment to "Stretched" in order to make the graphic any size.

If you like you can also enable this element to control the same device. Set the IgnorePresses property to False,
then click on the ActionsWhenRelease property. Add a HomeSeer Device action to toggle this device On/Off.

Now when you click on the element it will toggle the light and update the status.

See also How to Control a Light

See also
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Creating Projects
Working with Graphics
Working with Elements
Working with Actions
Working with Music
Working with RSS Data
Working with Video
Working with the Web
Working with Device Screens
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Home > Tutorials

Tutorials
Articles in this section

How to Control a
Light

How to Trigger an
Event

How to Create a
Weather Page

How to Send
Infrared Commands

How to Control a
Thermostat

How to View and
Control a Camera

How to Password
Protect a Screen

See also
Welcome
Getting Started
Working with Projects
Dynamic Screens
Advanced Functions
Mobile Clients
Designer Properties
Credits

Home > Tutorials > How to Control a Light

How to Control a Light
Here are three quick and easy ways to control a light using HSTouch.
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Control with a Device Element
This is the quickest and easiest way to add a basic button control to HSTouch.

Step 1 ‐ Drag/drop a device element from the Devices Palette to the design area of a screen ﴾as shown below﴿.
That's all you need to do! The button is already pre‐configured with the device name and device actions ﴾on/off﴿.

Operation: In the client, touch ﴾or click﴿ the control to toggle the Picture Window Lamp on or off.

Control with a Graphic Button Element
Use this option when working with graphic buttons.

Step 1 ‐ Drag/drop a Button ﴾or Graphic Button﴿ element from the Elements Palette to the design area of a screen
﴾as shown below﴿.
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Step 2 ‐ Select the button by clicking on it. In the Properties Pane, adjust the Text property to the name of the light
you're controlling; in this case, 'Picture Window Lamp'. Then, with the button still selected, click open the
'ActionsWhenReleased' property to bring up the Actions Editor ﴾as shown below﴿.

Step 3 ‐ Click 'Add' at the bottom of the 'Actions' list to assign your first action to the Picture Window Lamp button.
Then select the appropriate 'Action Type', 'Device' and 'Command' from the drop‐down menus in the Settings area
on the right. Note: You may add as many actions to this lamp button as you like and you may change the sequence
of the actions using the vertical arrows to the right of the Actions list. Click OK when finished.

Operation: In the client, touch ﴾or click﴿ the control to toggle the Picture Window Lamp on or off.

Control with a Slider Element
Use this option to when dimming control is required.

Step 1 ‐ Drag/drop a slider element from the Elements Palette to the design area of a screen ﴾as shown below﴿.
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Step 2 ‐ Select the slider element by clicking on it and adjust its 'Control Associations' by opening the
'StatusTracking' property on the Properties Pane. Set the 'Normal Association Type' to 'HomeSeer Devices' and then
choose the Picture Window Lamp from the menu of HomeSeer Devices ﴾as shown below﴿. Click OK to save those
changes.

Step 3 ‐ With Select the slider element still selected, adjust the following settings in the Properties Pane.
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OffsetMax / OffsetMin ‐ These settings restrict the distance that a pointer can travel within a slider. In this
example, the pointer will stop 15 pixels from each edge.

Orientation ‐ In this example, a vertical slider is used so this setting must be 'Vertical'.

TrackRealtime ‐ When set to 'True', devices will be controlled continuously as the pointer is moved. When set to
'False', devices will be controlled only when the pointer is released. Use 'True' for lighting devices that respond
quickly ﴾as with some hard‐wired and wireless technologies﴿. Use 'False' for lighting devices that respond more
slowly ﴾as with some powerline technologies﴿.

ValueInitial ‐ This sets the default position of the pointer if no status is detected.

ValueMax / ValueMin ‐ This sets the maximum and minimum values of the slider.

Operation: In the client, drag ﴾with finger or mouse﴿ the pointer to the desired dim level for the Picture Window
Lamp.

See also
How to Trigger an Event
How to Create a Weather Page
How to Send Infrared Commands
How to Control a Thermostat
How to View and Control a Camera
How to Password Protect a Screen
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Home > Tutorials > How to Trigger an Event

How to Trigger an Event
HomeSeer events may be triggered in HSTouch by assigning the appropriate event action to any control.

Example

Step 1 ‐ Drag/drop a button ﴾or other control﴿ to the design area of a screen ﴾as shown below﴿. Then, select the
button and re‐label it using the 'Text' property in the Properties Pane. In this case, the button will be used to trigger
a HomeSeer event called 'ALL LIGHTS OFF'.

Step 2 ‐ Select the button and open the settings for the 'ActionsWhenReleased' property on the Properties Pane
﴾as shown below﴿:

Step 3 ‐ At this point, the Action Editor will pop‐up ﴾as shown below﴿. Click 'Add' at the bottom of the 'Actions' list
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to assign your event action to this button. Now, select the Action Type 'HomeSeer: Trigger a HomeSeer Event' and
then choose your 'All Lights Off' event from the Event Name list. Click OK at the bottom and you're done!

See also
How to Control a Light
How to Create a Weather Page
How to Send Infrared Commands
How to Control a Thermostat
How to View and Control a Camera
How to Password Protect a Screen

Home > Tutorials > How to Create a Weather Page

How to Create a Weather Page
HSTouch is designed to import RSS data from a variety of sources including headline news, sports scores,
stock quotes, weather and much more. In this 'how‐to', we'll build a simple weather page that will display
the current temperature and 5‐day forcast.

The following procedure shows you how to create a weather screen using the default URL provided by
HSTouch. The default weather source is www.worldweatheronline.com. You can use other services such as
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weatherbug or weather underground. In the designer's RSS browser there are pre‐configured URL's for
weather bug as well as world weather online.

IMPORTANT: For this feed to work, you must obtain a weather API key from
www.worldweatheronline.com. The key is free. After you get your key you need to enter it in the HomeSeer
HSTouch settings. Go to HomeSeer‐>Setup‐>Interfaces then click on the Config button for the HSTouch
Server plugin.

NOTE: see here for more information on using weather data.

The steps below are for your information, luckily we have already created this screen for you as a template.
To use the template select the default skin from the Elements palette on the left, then select the "Custom"
tab. From there you can drag the Weather5DayRSS to your screen and have the complete forecast screen
done.

If you would like to learn how to create your own weather screen, follow the steps below

Step 1 ‐ Create a new project or add a new screen to an existing project.

Step 2 ‐ Drag/drop the weather page background from the Elements Palette to your new screen ﴾as
shown below﴿.
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Step 3 ‐ Drag/drop a text element from the 'Others' tab of the Elements Palette ﴾as shown below﴿.

Step 4 ‐ Select the text element by clicking on it and change the following properties in the Properties
Pane.

ColorNormal ‐ Set this to transparent ﴾as shown below﴿.
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FontColorNormal ‐ Set this to white.

FontNormal ‐ Set this 16 pt, Arial Black.

The text element should now look like this:

Step 5 ‐ With the text element still selected, move back to the Properties Pane and open the settings for the
'StatusTrackingNormal' property ﴾as shown below﴿:

Step 6 ‐ At this point, the Control Associations window will open ﴾as shown below﴿. Since the text element is for
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display only, check the box for 'Use the same for Normal/Pressed'. Now, open the Normal Association Type menu
and choose RSS Data. Then select the radio button for 'Use Status Text' at the right and click the 'Edit' button.

Step 7 ‐ The next window to appear is the RSS Data Browser ﴾shown below﴿. Select 'Weather Forecast' from the
'Common RSS Feeds'. Note that the feed uses Longitude and Latitude variables to note your location. These
variables are automatically replaced with the Latitude and Longitude that are set in HomeSeer. If the weather
information looks incorrect, check the Location setting in HomeSeer Setup. Now, click the 'Get Data' button and
use the arrow buttons near the right of the window to advance the table named "weather". The table name is
display toward the bottom right of the screen. This will display the current 5 day forecast. Each row in this table is a
different day. We want to display the day for the first day of the forecast. Unfortunately, this RSS feed gives us the
day as date, such as 2012‐02‐25. You can simply select that and it will be displayed as the current day, or we can
modify that value with some script and get the current day name, such as "Sat". For now we will leave it as is, select
the first date in the first row as shown.
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At this point, the design area will once again appear and the text element will now display the first column day as
shown below. Note that it is displaying the current date and the text is too large. You can change the text size to fit,
or change this date to a day. We will change it to display the day.

To change the display to a day we need to run a script. The script is a single command that takes the date and
extracts the current day. The script command we will be using is the VBScript command:

WeekDayName
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To use this script command we need to pass it the current date as seen above. This is returned by the RSS. We will
use some variable substitution get the RSS data. See the Replacement Variables section for details on these
commands. The entire command we construct will need to placed in the text elelment "Text" property. Looking at
the RSS data in the properties pane we see the following information that denotes this particular piece of RSS data
﴾first day of forecast date﴿:

RSS URL=http://free.worldweatheronline.com/feed/weather.ashx?q=[$LATITUDE],
[$LONGITUDE]&format=xml&num_of_days=5&key=[$WEATHERAPIKEY]
Table Name=weather
Item Name=date
Row Number=0

We can now take this information and create a replacement variable that we insert into the elements Text property.
Here are the parts we will be using:

The following is an RSS replacement variable that simply accesses the one piece of information from the RSS feed
that we need. In this case, the following line simply returns the date as "2010‐02‐25"
[$RSS=http://free.worldweatheronline.com/feed/weather.ashx?q=[$LATITUDE],
[$LONGITUDE]&format=xml&num_of_days=5&key=[$WEATHERAPIKEY]‐>weather‐>date‐>0]

If we assigned the above line to the elements Text property, we only get the date ﴾as we do now﴿. To get the day,
we need to pass this date to our WeekDayName function. The total like looks like this:

[$SCRIPT=&WeekDayName﴾WeekDay﴾"[$RSS=http://free.worldweatheronline.com/feed/weather.ashx?q=
[$LATITUDE],[$LONGITUDE]&format=xml&num_of_days=5&key=[$WEATHERAPIKEY]‐>weather‐>date‐>0]"﴿,true﴿]

The "[$SCRIPT]" replacement variable tells the system to run a script and the script is named $WeekDayName. The
"&" in front of the script command tells HomeSeer that is a single command and not a script file.

Now we assign that entire line to the Elements Text property like so:
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Before the new day will show up, we need to remove the RSS association from the StatusTrackingNormal property,
set the tracking to None. The RSS overrides the Element's Text property.

Now the Text element looks like this and displays just the day:

Step 8 ‐ Now, repeat this procedure for all the other columns and all of the other data fields ﴾and graphics
fields﴿ for the weather screen. Your finished screen should look something like this:

NOTE: You can also use weather data from weatherbug.com, this is available from the pre‐configured
URL's drop list. You still need to obtain your own API key from weatherbug.com.
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See also
How to Control a Light
How to Trigger an Event
How to Send Infrared Commands
How to Control a Thermostat
How to View and Control a Camera
How to Password Protect a Screen

Home > Tutorials > How to Send Infrared Commands

How to Send Infrared Commands
One common action is to assign an infrared command to a button, to change the channel on the
television for example. There are 2 ways to do this. This How To assumes that you have already added an
infrared controller to HomeSeer and have created your infrared commands from the Infrared plugin
configuration screen.
HS3 supports Infrared through the use of plugins. Multiple Infrared plugins can be loaded at the same
time.

Option 1

Create an event in HomeSeer that sends the infrared command you want. In HSTouch add an action to a
button and set the action to trigger the HomeSeer event. This is the easiest method but can be time
consuming if you have a lot of infrared commands. Also, maintaining the commands can be a bit of work
since you are maintaining the events in HomeSeer as well as the trigger name in HSTouch.

Option 2

HSTouch has the ability to execute script commands directly from a button. All Infrared plugins should
support the "SendIR" function. To call the SendIR function directly from HSTouch a script command can be
added as an action. Note the name of the plugin you are using to send the IR command. For example, if
you are using the Sq Blaster plugin, the plugin name is "SQ Blaster". To send the IR command the plugin is
accessed with the hs.PluginFunction call. The format of the call is:
hs.PluginFunction﴾[plugin name],"SendIR",[instance],[paramters]﴿
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In most cases, the instance parameter is an empty string unless the plugin supports multiple instances,
then the instance parameter will be the instance name.

In HSTouch, create a new button and set the action to run a HomeSeer script. In the script name box
enter:

&hs.PluginFunction("SQ Blaster","","SendIR","sony_tv,power_on")

If you need to send multiple commands, for example, to change to channel 12:

&hs.PluginFunction("SQ Blaster","","SendIR","sony_tv,1,2")

If you need to delay your commands, add more commas. Each comma adds a 1/4 sec delay. For example,
this adds a delay between the 1 and 2:

&hs.PluginFunction("SQ Blaster","","SendIR","sony_tv,1,,2")

Leave all the other options in the run script action blank.

See also
How to Control a Light
How to Trigger an Event
How to Create a Weather Page
How to Control a Thermostat
How to View and Control a Camera
How to Password Protect a Screen

Home > Tutorials > How to Control a Thermostat
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How to Control a Thermostat
HSTouch includes some templates that allow you to easily add thermostat control. Before adding a
thermostat to your project, make sure HomeSeer can control the thermostat ok using one of the
Thermostat plug‐ins. If you don't have any thermostat plug‐ins installed, you may install one using the
HomeSeer updater. HomeSeer supports RCS, Aprilaire, HAI, Proliphix, and other thermostats. A plug‐in for
your thermostat must be installed and enabled before HSTouch can control the thermostat.

Once the plug‐in is installed and operating, click on the Thermostats tab in the HSTouch Designer elements
palette. There you will find some sample templates for many of the supported thermostats. Simply drag the
desired thermostat to your screen. A dialog will be displaye asking you which thermostat you want to
assign this template to. If no thermostats are displayed, HomeSeer has not yet been configured for a
thermostat.

After selecting your thermostat, all the elements in the template will be altered to control and monitor your
thermostat. This includes all actions and status associations. You can now customize the design to your
needs.

See the Appendix, Actions Types section for more information on the thermostat actions.

To display thermostat status, click on the StatusTrackingNormal property in the properties pane to assign
associations to your elements.

The thermostat templates are identical in operation. If your specific thermostat is not available, pick any of
the existing thermostats and modify as needed.
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RCS Style Thermostat

See also
How to Control a Light
How to Trigger an Event
How to Create a Weather Page
How to Send Infrared Commands
How to View and Control a Camera
How to Password Protect a Screen

Home > Tutorials > How to View and Control a Camera

How to View and Control a Camera
Some web cameras support pan and tilt options. It may be desirable to control these cameras directly from an
HSTouch screen. By using scripting commands, you can access a camera using a URL. If you do not know how to
access the camera image, see the ImageURL property of the image element.

Many cameras use a simple URL command to pan and tilt the camera. For example, the 4XEM camera uses the
following command to move the camera:

HSTouch

68

Chapter 4 Tutorials

http://192.168.1.120/cgi-bin/camctrl.cgi?move=left

If you entered this URL in your web browser, the camera would move to the left. In order for HSTouch to send this
command, the URL needs to be sent to HomeSeer. HomeSeer will then send this URL to the IP address given.

Add a new button to your camera screen and click on the "..." next to "Actions when Released". This brings up the
action editor. Select the "HomeSeer: Run a script with parameters" action. In the Script property, enter this:

&hs.GetUrl("http://192.168.1.120/cgi-bin/camctrl.cgi?
move=left","",True,80)

(Make sure you change the IP address to the address of your camera!)

Your action should look as follows. Click OK to save the action. When you run your project and click the button, the
camera will pan left.

To move the camera up, down, and right, create 3 more buttons and change the action to replace the word "left"
with "up", "down", or "right".

If you are not using a 4XEM camera, consult the cameras documentation to see what the URL is to move the
camera.
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See also
How to Control a Light
How to Trigger an Event
How to Create a Weather Page
How to Send Infrared Commands
How to Control a Thermostat
How to Password Protect a Screen

Home > Tutorials > How to Password Protect a Screen

How to Password Protect a Screen
There may be times when you want to protect a screen from being accessed. Maybe you have a screen that
allows you to arm and disarm your security panel. This type of screen should not be allowed access by just anyone.
In these cases, you can add a password to a screen. This is done by clicking on a screen then enter the passcode
in the Passcode property.
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After entering the passcode and hitting Enter, the designer will automatically create a passcode keypad screen for
you. You can then edit this screen if you like.

When a user attempts to access a screen that has a passcode set, the passcode screen will display and the user
needs to enter the proper passcode before the desired screen will display.

If you edit the passcode screen, do not change the screen name. The screen must be named Passcode, or it will
not display when needed. There may be different passcode screens available, select the Skin you would like to
work with, then select the Custom tab from the elements pallette, then drag the passcode template onto your
screen. Make sure you name the screen Passcode.

See also
How to Control a Light
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How to Trigger an Event
How to Create a Weather Page
How to Send Infrared Commands
How to Control a Thermostat
How to View and Control a Camera
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Home > Dynamic Screens

Dynamic Screens
A dynamic screen is a screen that displays content from different sources automatically. The default project
that is included with the IOS and Android applications contain many examples of dynamic screens. These
screens make it easy to create a project that is not specific to any one installation of HomeSeer. Most
custom projects reference specific devices on the home system and when this is done, the project will not
work on any other system.
Dynamic screens are specially named or use special Device Types, and are displayed normally using a
button. A button to display a camera screen is set to have its action to "Display Another Screen". The
camera screen is named "camera_viewer". This name is special and HSTouch knows that this screen is to be
used to display a camera view. When the button is pressed to go to this screen, the system will display a
chooser page where the user can pick the camera they want to view. All dynamic screens work this way, a
chooser is first displayed so the user can select a camera, a lighting device, a thermostat, or an energy
device. See the sub sections for the format of each dynamic screen.
The chooser is another special screen that must be added to the project, see the Device Chooser topic.
When creating screens for a project where both landscape and portrait modes are supported, you can add
a landscape version of a screen by adding "‐L" to the screen name. For Windows projects, this is not
supported, only one screen is required.

See also
Welcome
Getting Started
Working with Projects
Tutorials
Advanced Functions
Mobile Clients
Designer Properties
Credits

Home > Dynamic Screens > Lighting Control

Lighting Control
HSTouch
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A lighting control special screen allows for the control of a light, this includes On/Off buttons and a
dimming slider. Labels are used to display the name and location of the device. HSTouch knows how to set
the elements based on the element name. You can lay out the screen as you like, but use the element
names below so they display properly.
This screen does not need a special name and can have any name.
The screen is displayed from the device browser list when a user selects a lighting device. The screen needs
to have the device type property filled in with the device types it needs to support. For example, you want
this screen to control dimming Z‐Wave devices, so add the following device type to the device types
property:
"Z‐wave Switch Multilevel"
The device type of any device can be found under the Advanced tab on the Device Management Page.
Note for plugin authors:
The HSTouch clients also look at the ControlUse property on a device, and if a ControlUse for dimming is
set, this screen will also be displayed. This is a way for HSTouch to know that the device supports dimming.
Special elements on this screen, use the following as the name of the element:
Name Property
Element
﴾use this for the Description
Type
name﴿
Label devicename
Will be set to the name of the device
Label devicelocation1 Will be set to the location 1 name
Label devicelocation2 Will be set to the location 2 name
Set an association to any existing device, and set the association type to status.
can be any
Label
The association will be replaced with the target device and the element display
name
text will be set to the device status, such as "On", "Off", "Dim 50%"
If the screen is to control a dimming device, add an association to any existing
Slider dimslider
dimming device. The association will be replaced with the target device.

See also
Energy
Cameras
Thermostats
Device Chooser
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Home > Dynamic Screens > Energy

Energy
The Energy screen is used to display realtime data for an Energy device such as a whole house Energy
Meter or a smart plug‐in module. It can display a round gauge for current energy use a graph if history
data for the selected device.
Note: The graph colors can be set using the Designer project defaults dialog.
Required screen name: energy_viewer

Name
Element Property ﴾use
Type
this for the
name﴿
Label
devicename
Label
watts
Label
amps
Label
kwh
Label
volts
Progress
Bar ﴾can
watts
be type
Gauge﴿
Progress
Bar ﴾can
amps
be type
Gauge﴿
Progress
Bar ﴾can
kwh
be type
Gauge﴿
Progress
Bar ﴾can
volts
be type
Gauge﴿
Image
energy_graph
DropList

HSTouch
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Description
Will be set to the name of the device that was selected
Will be set to the watts value of the device
Will be set to the amps value of the device
Will be set to the kwh used for the device
Will be set to the volts value of the device
Element value will be set to the device's watts value

Element value will be set to the device's amps value

Element value will be set to the device's kwh value

Element value will be set to the device's volts value
This will display an energy graph of historic data for this device
Can be used to set the type of graph displayed. Set the action for the drop list to
set the graph type for nergy graph image. The default type can be selected.
Then the drop list is selected, the desired graph will be displayed on the Element
named "energy_graph".
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See also
Lighting Control
Cameras
Thermostats
Device Chooser

Home > Dynamic Screens > Cameras

Cameras
The camera screen is used to display a camera view. This screen works with the cameras that are configured
in the HSTouch Server plugin. By default, Foscam cameras are automatically discovered and will be
available from any HSTouch application.
Require screen name: camera_viewer
Whenever this page is to be displayed, a camera chooser page is automatically displayed first so the user
can pick a camera.
The following elements can be added to this page.
Element TypeName Property ﴾use this for the name﴿
Image
camera
Buttonl
panleft
Button
panright
Button
panup
Button

pandown

Description
Will display the camera image
Will be set to an action to pan the camera left
Will be set to an action to pan the camera right
Will be set to an action to pan the camera up
Will be set to an action to pan the camera down

See also
Lighting Control
Energy
Thermostats
Device Chooser
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Home > Dynamic Screens > Thermostats

Thermostats
Thermostat control screens are similar to lighting control screens in that it uses device types, see the
Lighting Control section for details. The device type for a Z‐Wave thermostat is "Z‐Wave Thermostat".
Check the HomeSeer Device Management page for the device type name of any other thermostats you
want the screen to control. Device Types use will be phased out soon and the new HS3 device type API will
be used.
Required screen name: Thermostat
When this screen is to be displayed, a thermostat chooser screen is automatically displayed so the user can
select the thermostat they want to control.
Name Property
Element
﴾use this for the Description
Type
name﴿
Label devicename
Will be set to the name of the device
Label devicelocation1 Will be set to the location 1 name
Label devicelocation2 Will be set to the location 2 name
Set an association to any existing thermostat data point, such as mode, setpoint,
Various can be any
etc. Set the association to any existing thermostat. The association will be
Labels name
replaced with the target device.
Add any other controls that you need to control the thermostat such as buttons
Various can be any
to raise a setpoint, or change the mode. Set the association to an existing
Controls name
thermostat. The association will be replaced with the target device.

See also
Lighting Control
Energy
Cameras
Device Chooser

Home > Dynamic Screens > Device Chooser

Device Chooser
HSTouch
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When dynamic screens are used, a device chooser screen is displayed just before the target screen so the
user can pick the device they want to control. For example, you have a button that displays the screen
named "Thermostat'. This is a special screen and before the screen can displayed, the system needs to
know which thermostat to control. So a screen named "DeviceChooser" is displayed. This screen only needs
to have one element, a ListBox. This ListBox is loaded with all of the devices that match the target. In this
example, only thermostats will be in the list. This screen must be present in your project or the dynamic
screens will not function.
Required screen name: DeviceChooser
Required Elements: Single ListBox, usually sized to the full size of the screen.

See also
Lighting Control
Energy
Cameras
Thermostats
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Home > Advanced Functions

Advanced Functions
Articles in this section

Command Line
Options

Controlling Clients
from HomeSeer

Customizing the
Application for
Installers

Date Time
Functions

Replacement
Variables

Speaking Text To
Speech ﴾TTS﴿

HSTouch Server
Plug‐in

See also
Welcome
Getting Started
Working with Projects
Tutorials
Dynamic Screens
Mobile Clients
Designer Properties
Credits

Home > Advanced Functions > Command Line Options

Command Line Options
HSTouch may be run from a command line or from a batch file. Here are the command line switches:
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‐ h Display help about which command line switches are available.
‐ p [config file] Start HSTouch and load the specified configuration XML file. The file name is the full
path to the XML file that is to be loaded.
‐s HSTouch will check if there is already an existing instance of the HSTouch EXE running. If so, it will
silently exit. This keeps multiple instances of the application from running. If the existing application is
currently minimized to the system tray, it will be restored and brought to the front.
‐ t Force adding a title bar to all screens. Mainly needed on some Linux and Unix systems that will not
allow dialogs to display if the titlebar setting is not enabled.
‐ n Do not show the client in the system task bar
‐ a [HOST_ADDRESS] sets the IP address or host that this client should connect to IE: HSTouch.exe ‐a
192.168.1.2

See also
Controlling Clients from HomeSeer
Customizing the Application for Installers
Date Time Functions
Replacement Variables
Speaking Text To Speech ﴾TTS﴿
HSTouch Server Plug‐in

Home > Advanced Functions > Controlling Clients from HomeSeer

Controlling Clients from HomeSeer
There may be times when its desirable to control an HSTouch from an event in HomeSeer. For example, you want
to display specific web sites on an HSTouch screen based on information gathered from HomeSeer. Someone
comes to the front door and you want the video of the person to immediately show up on all client screens.

There are 2 ways to control HSTouch clients.

1. Plug‐in Actions
2. Scripting
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Plug‐In Actions

When the HSTouch Server plug‐in is enabled in HomeSeer there are new event actions available when an event is
created.

Send Message to All Clients ﴾Broadcast﴿
Sends a text message to all clients. The client will display a message box that displays the message. The
message can be formatted using HTML.
Send Message to Specific Client
Sends a text message to a specific client. The message may be formatted the same as the broadcast
message.
Display a Screen by Itself
Forces the client ﴾or all clients﴿ to display a specific screen. Enter the screen name that you want to display.
Display a Screen on Top of another Screen
Forces the client ﴾or all clients﴿ to display a screen on top of an existing screen. Enter the screen name that
you want to display.
Set URL property of an Element
Use to force an element to display a different URL. The Element is immediately updated.
Simulate the Press of an Element
Causes and element to be pressed, its pressed display state is displayed and any actions associated with the
element are executed. Note that the element will stay in the pressed state until a released action is sent to it.
To execute an action that is not available in the HomeSeer HSTouch actions list, create a button on one of
your screens and make the background transparent and clear the text property. Add the desired action to
the button. The button action can be triggered from HomeSeer using this action and it won't be visible to the
user. These "invisible" buttons can be placed on a screen that is not accessible.
Simulate the Release of an Element
Same as the Press action but forces the release actions of the element to be executed.

Scripting

From a HomeSeer script you can execute the same actions from above. The hs.TriggerEvent can be used to trigger
an event that executes one of the above actions, or you can execute the action directly from within your script. The
following script commands are available:

Public Sub BroadcastMessage﴾ByVal msg As String, ByVal duration As String, ByVal client As
String﴿
This will send a text message to all clients or a specific client
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msg: The message to send, can include HTML
duration: Time in the format minutes:seconds ﴾IE: 0:10 for 10 seconds﴿
client: The name of the client in the form ﴾host:name﴿ or an empty string for all clients.
Public Sub ClientAction﴾ByVal action_type As Integer, ByVal destination As String, ByVal parm1
As String, ByVal parm2 As String﴿
Force an action to be executed on a specific client or all clients
action_type: This is number that is the type of action to execute. Supported action numbers are listed
below
60 = Display a screen by itself. Parameter 1 is the screen name to display.
70 = Display a screen on top of another screen. Parameter 1 is the screen name.
43 = Set the URL property of an element. Parameter 1 is the element name in the format
﴾screen:element﴿. Parameter 2 is the URL that is to be set to the element.
30 = Simulate a press of an element. Parameter 1 is the element name in the format ﴾screen:element﴿.
35 = Simulate a release of an element. Parameter 1 is the element name in the format
﴾screen:element﴿.
destination: This is the client that is to execute the action. The client name is in the format ﴾host:name﴿
and an empty string indicates all clients.
parm1: The first parameter for the action such as the element or screen name. See the action types
above for parameter values.
parm2: The second parameter for the action such as the element name. See the action types above
for parameter values.
Public Sub ThermostatChanged﴾﴿
This call notifies the HSTouch plugin that there was a change to one of the thermostats. The plug‐in will then
update its internal status of all thermostat data by contacting all attached thermostats to retrieve an update.
Use this function if you have scripts that update thermostats using the HomeSeer Thermostat plug‐in API.
Normally, the HSTouch plug‐in will retrieve data every 15 seconds.

The following sample script will display the main screen on all clients. Note that only .NET scripts are supported.
Name this script with a .vb extension. Note that there are 2 versions of the HSTouch Server plug‐in. The standard
version is limited to 5 connections and is named "HSTouch Server", the upgrade version supports unlimited
connections and is named "HSTouch Server Unlimited". You should search for both as you don't know which one
will actually be installed.

Sub Main(parm as object)
' the plugin object
dim hstplug as object

' get a reference to the HSTouch Server plugin
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hstplug = hs.plugin("HSTouch Server")

' make sure the reference is good
if hstplug is nothing then exit sub

' call the method on the plugin to perform the action
hstplug.ClientAction(60,"","main","")

End Sub

See also
Command Line Options
Customizing the Application for Installers
Date Time Functions
Replacement Variables
Speaking Text To Speech ﴾TTS﴿
HSTouch Server Plug‐in

Home > Advanced Functions > Customizing the Application for Installers

Customizing the Application for Installers
If you are installing HSTouch for your own business you may want to brand the product with your own name. The
startup splash screens may be changed and replaced with your own screens. To do this, add the file:

CustomSplash.bmp

This file should be located in the root directory where the executable program file is located ﴾HSTouch.exe,
HSTouchDesigner.exe, or CE5HSTouch.exe﴿ When the application loads, it will use this splash screen instead of the
standard one. The bitmap files need to be these sizes:

For the HSTouch Designer application: 492 x 300 pixels
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For the HSTouch Windows Client: 492 x 300 pixels
For the HSTouch Windows CE Client: 180 x 200 pixels

See also
Command Line Options
Controlling Clients from HomeSeer
Date Time Functions
Replacement Variables
Speaking Text To Speech ﴾TTS﴿
HSTouch Server Plug‐in

Home > Advanced Functions > Date Time Functions

Date Time Functions
HSTouch includes a built‐in function to display the current date and time. To use this function, simply add a text
element to the screen and enter the appropriate date and time variables in that element's text property ﴾as shown
below﴿.

Standard Date and Time Variables
Use the standard date and time variables to display date and time as shown below.

Variable

HSTouch
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[$DATETIME]:

10/4/2008 12:51:30 PM

[$DATE]:

October 4 2008

[$TIME]:

12:51 PM

Custom Date and Time Variables and Formats
To customize the format of the date or time displayed, use these variables with the appropriate characters listed in
the table below.

[$DATE=dd MM yy] ﴾where dd=day, MM=month, yy=year﴿

[$TIME=hh:mm tt] ﴾where hh=hour, mm=minute, tt=AM/PM﴿

Note: When using custom formats, it makes no difference which variable you use [$DATETIME], [$DATE], or
[$TIME] as they will all display the same thing. You can mix formats specifiers to display the date and time such as:
[$DATE] [$TIME].

Character

Description

﴾:﴿

Time separator. In some locales, other characters may be used to represent
the time separator. The time separator separates hours, minutes, and
seconds when time values are formatted. The actual character used as the
time separator in formatted output is determined by your application's
current culture value.

﴾/﴿

Date separator. In some locales, other characters may be used to represent
the date separator. The date separator separates the day, month, and year
when date values are formatted. The actual character used as the date
separator in formatted output is determined by your application's current
culture.

﴾%﴿

Used to indicate that the following character should be read as a single‐
letter format without regard to any trailing letters. Also used to indicate that
a single‐letter format is read as a user‐defined format. See below for
further details.

d
dd

HSTouch

Displays the day as a number without a leading zero ﴾for example, 1﴿. Use
%d if this is the only character in your user‐defined numeric format.
Displays the day as a number with a leading zero ﴾for example, 01﴿.

ddd

Displays the day as an abbreviation ﴾for example, Sun﴿.

dddd

Displays the day as a full name ﴾for example, Sunday﴿.
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M
MM
MMM
MMMM
gg

Displays the month as a number without a leading zero ﴾for example,
January is represented as 1﴿. Use %M if this is the only character in your
user‐defined numeric format.
Displays the month as a number with a leading zero ﴾for example, 01/12/01﴿.
Displays the month as an abbreviation ﴾for example, Jan﴿.
Displays the month as a full month name ﴾for example, January﴿.
Displays the period/era string ﴾for example, A.D.﴿.

h

Displays the hour as a number without leading zeros using the 12‐hour
clock ﴾for example, 1:15:15 PM﴿. Use %h if this is the only character in your
user‐defined numeric format.

hh

Displays the hour as a number with leading zeros using the 12‐hour clock
﴾for example, 01:15:15 PM﴿.

H

Displays the hour as a number without leading zeros using the 24‐hour
clock ﴾for example, 1:15:15﴿. Use %H if this is the only character in your
user‐defined numeric format.

HH

Displays the hour as a number with leading zeros using the 24‐hour clock
﴾for example, 01:15:15﴿.

m

Displays the minute as a number without leading zeros ﴾for example,
12:1:15﴿. Use %m if this is the only character in your user‐defined numeric
format.

mm
s
ss
t

tt

Displays the minute as a number with leading zeros ﴾for example, 12:01:15﴿.
Displays the second as a number without leading zeros ﴾for example,
12:15:5﴿. Use %s if this is the only character in your user‐defined numeric
format.
Displays the second as a number with leading zeros ﴾for example, 12:15:05﴿.
Uses the 12‐hour clock and displays an uppercase A for any hour before
noon; displays an uppercase P for any hour between noon and 11:59 P.M.
Use %t if this is the only character in your user‐defined numeric format.
For locales that use a 12‐hour clock, displays an uppercase AM with any
hour before noon; displays an uppercase PM with any hour between noon
and 11:59 P.M.
For locales that use a 24‐hour clock, displays nothing.

y
yy

HSTouch

Displays the year number ﴾0‐9﴿ without leading zeros. Use %y if this is the
only character in your user‐defined numeric format.
Displays the year in two‐digit numeric format with a leading zero, if
applicable.

yyy

Displays the year in four‐digit numeric format.

yyyy

Displays the year in four‐digit numeric format.
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z
zz
zzz

Displays the timezone offset without a leading zero ﴾for example, ‐8﴿. Use
%z if this is the only character in your user‐defined numeric format.
Displays the timezone offset with a leading zero ﴾for example, ‐08﴿.
Displays the full timezone offset ﴾for example, ‐08:00﴿.

Examples
The following are examples of user‐defined date and time formats for December 7, 1958, 8:50 PM, 35 seconds:

Format

Displays

M/d/yy
d‐MMM
d‐MMMM‐yy
d MMMM
MMMM yy

12/7/58
7‐Dec
7‐December‐58
7 December
December 58

hh:mm tt

08:50 PM

h:mm:ss t

8:50:35 P

H:mm
H:mm:ss
M/d/yyyy H:mm

20:50
20:50:35
12/7/1958 20:50

See also
Command Line Options
Controlling Clients from HomeSeer
Customizing the Application for Installers
Replacement Variables
Speaking Text To Speech ﴾TTS﴿
HSTouch Server Plug‐in

Home > Advanced Functions > Replacement Variables
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Replacement Variables
There are a number of replacement variables that you can use to display specific information on buttons and
labels. Date/Time information is one such variable. See the Date/Time description for a list of these variables. To
use these variables, simply enter them in the text property of a button or text element.

Variables take the format [$VARNAME], where VARNAME is the name of the variable. The entire variable is
replaced with the desired text. For example, the DATE and TIME variables will display the current data and time.
The [$RSS] variable will insert RSS data from the web. Text can also be manipulated using the [$REGEXREPLACE]
and [$REGEXMATCH] variables.

Variables available

[$DATE], [$TIME], [$DATETIME]

See the Date/Time Function topic for more details on how to use these variables.

[$FREEMEM]

This will display the free memory available on a Windows CE device. It will display "N/A" on other platforms. This
information can be helpful when you are developing screens for CE devices as CE devices have limited memory.
For example, in the Text property of a text element enter:

Memory free = [$FREEMEM]

[$SCRIPT]

Allows you to call a scripting function in HomeSeer. The function is run on the HomeSeer server and the result is
returned. For example, if you wanted to get the actual value of a HomeSeer device, divide this value by 10, then
display the result on a button, you could enter the following in the text property for the button:

[$SCRIPT=&hs.DeviceValue﴾126﴿/10]

This calls the HomeSeer script function called "DeviceValue", passes it the device reference of the device "126",
HSTouch
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This calls the HomeSeer script function called "DeviceValue", passes it the device reference of the device "126",
takes the value of the device and divides it by 10, then returns the result. The "&" tells HomeSeer this is an
immediate function, not a full script, and is required. If you want to run a more complex script on HomeSeer, you
can run it with:

[$SCRIPT=&hs.runex﴾"scriptname.txt","Main",""﴿]

This will run the script named "scriptname.txt" and call the "Main"' function and return the result.

See the HomeSeer helpfile for documentation on the available script functions.

[$LOCATION1], [$LOCATION2]

These return the actual names of Location1 and Location2 as set in HomeSeer.

[$ELEMENT=screen_name‐>name]

Returns the text that is displayed in a specific element. The screen name and the element name need to be
specified.

The following replacement variables require HSTouch client (Windows,Windows CE, Linux) 1.0.0.23 or
later or the iPhone/iPod Touch client version 1.4 or later.

[$ZIPCODE]

When this appears in a text element or an RSS URL, it will be replaced with the zipcode as entered in the project
properties. On the iPhone/iPod Touch it will be replaced with the zipcode as entered in the HSTouch settings on
the iPhone itself. This is used in the Weather5DayRSS.xml custom group that is available under the Custom tab in
the elements palette.

[$BATTERY]

On the iPhone/iPod Touch/iPad the current battery level can be displayed. This will insert the battery level as a
number between 0 and 100.
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[$REGEXREPLACE=input‐>pattern‐>replacement]

This uses regular expressions to search for a pattern and replace it with another pattern. For example, you have a
device in HomeSeer that displays the motion status as "No Motion" or "Motion". You want to change the word
"Motion" to "Movement". Add a new text element to your screen and enter the following in the Text property:

[$REGEXREPLACE=[$SCRIPT=&hs.devicestring﴾"Q22"﴿]‐>Motion‐>Movement]

This does the following:
It retrieves the current string for the device using the script command hs.DeviceString
We then search this string for the word "Motion" and replace it with "Movement"

[$REGEXMATCH=input_string‐>pattern]

Returns a string that matches the regular expressing pattern. See complex example below for an example.

[$RSS=url‐>table‐>item‐>row]

This will access the RSS feed URL give and retrieve the data from the specified table, item, and row. To get the
table, item, and row, use the RSS data editor by clicking on an element, then click on status associations, then select
RSS for the association. This will display the RSS editor and will display the information you need at the bottom of
the dialog.

For example, you want to get the latest icon for the current weather conditions:

[$RSS=http://api.wxbug.net/getLiveWeatherRSS.aspx?
ACode=A5679336775&zipcode=03110&unittype=0‐>current‐condition‐>icon‐>0]

Or, get the top news headline from YAHOO news:

[$RSS=http://rss.news.yahoo.com/rss/topstories‐>item‐>title‐>0]
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Or, CNN top story ﴾set the element IsHTML to True so pictures display﴿:

[$RSS=http://rss.cnn.com/rss/cnn_topstories.rss‐>item‐>description‐>0]

Complex RSS and regular expression example:

Documentation on regular expressions can be found on the Internet.

In this example we want to display a transparent gif that displays the current weather conditions. The weatherbug
RSS has a feed that will return the current icon, but it's a standard GIF. The transparent icon is available from the
following URL:

http://img.weather.weatherbug.com/forecast/icons/localized/60x50/en/trans/cond007.png

What we need to do is replace the "007" with the current condition code. We can get the condition code from this
URL:

[$RSS=http://api.wxbug.net/getLiveWeatherRSS.aspx?
ACode=A5679336775&zipcode=03110&unittype=0‐>current‐condition‐>icon‐>0]

The above returns:

http://deskwx.weatherbug.com/images/Forecast/icons/cond054.gif

So we now need to extract the "054" from the string returned and use that in the URL for the transparant
PNG. We can do that with:

[$REGEXMATCH=http://deskwx.weatherbug.com/images/Forecast/icons/cond054.gif‐>﴾cond.{3}﴿]

This returns: "cond054"

To put this altogether:
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http://img.weather.weatherbug.com/forecast/icons/localized/60x50/en/trans/[$REGEXMATCH=
[$RSS=http://api.wxbug.net/getLiveWeatherRSS.aspx?
ACode=A5679336775&zipcode=03110&unittype=0‐>current‐condition‐>icon‐>0]‐>﴾cond.{3}﴿].png

To display this, add an Image element to your screen and enter the above text for the ImageURLNormal property.

Note, when nesting [$###] replacement vars you can only nest 1 deep.

See also
Command Line Options
Controlling Clients from HomeSeer
Customizing the Application for Installers
Date Time Functions
Speaking Text To Speech ﴾TTS﴿
HSTouch Server Plug‐in

Home > Advanced Functions > Speaking Text To Speech ﴾TTS﴿

Speaking Text To Speech ﴾TTS﴿
HSTouch clients have the ability to speak text to speech that is generated by HomeSeer. In HomeSeer, speech is
normally sent to the Speaker Client application. This is a small application that is run on any Windows PC on your
network. HomeSeer can then send speech to this application. HSTouch clients have the same functionality. This
allows for speech to be sent to any Windows, iPhone, iPad, or Windows CE device that is running the HSTouch
client. To send speech to an HSTouch client, note the following:

* Note the client/name of the HSTouch client you want to speak to. This is the name of the computer and the client
name as listed in the Connection dialog on the HSTouch client. Right click in the upper right corner of the HSTouch
screen ﴾or hold down the left mouse button﴿ to display the Connection dialog as shown:
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If the name of this PC was called "MyPC", then client name for this HSTouch client is: MyPC:race2

You will need this name for use in HomeSeer if you want to send speech to this client only.

* Create a new event in HomeSeer and add an action to Speak. Enter a speak phrase in the text box. If you want to
speak to all clients, you are done. Execute the event to test. If you want to speak to a specific HSTouch client, enter
the name of the client in the instance text box. In this case you would enter "MyPC:race2". See the HomeSeer
documentation on other formats for the client name.

The default speech format is 16khz 16bit wave file format. This may create a large speech file that needs to be sent
to the client. On low bandwidth clients such as the iPhone or Windows CE clients this may result in a larger delay
before the client speaks. To reduce the amount of data sent to the client you can change the format to 8khz 8bit
which results in a much smaller file size and reduces the delay. To change the speech format edit the file
"hspi_HSTouch.ini" which is located in the HomeSeer config folder. Enter or edit the following line:

SpeakFormat=4

The default format is 16khz 16bit which is a format number of 18. There are other formats available:

8khz 16bit = 6
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8khz 8bit = 4
11khz 16bit = 10
11khz 8 bit = 8
12khz 16bit = 14
12khz 8bit = 12
16khz 16bit = 18
16khz 8bit = 16
22khz 16bit = 22
22khz 8bit = 20
24khz 16bit = 26
24khz 8bit = 24
32khz 16bit = 30
32khz 8bit = 28
44khz 16bit = 34
44khz 8bit = 32
48khz 16bit = 38
48khz 8bit = 36

Note: Text‐to‐speech support requires HSTouch client version 1.0.0.41 or later ﴾for Windows, Windows CE clients﴿
and version 1.10 or later for iPad/iPhone/iPod clients﴿ Also, the HomeSeer HSTouch server pugin must be version
1.0.016 or later.

See also
Command Line Options
Controlling Clients from HomeSeer
Customizing the Application for Installers
Date Time Functions
Replacement Variables
HSTouch Server Plug‐in

Home > Advanced Functions > HSTouch Server Plug‐in
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HSTouch Server Plug‐in
In order for HSTouch to function, the HomeSeer HSTouch plug‐in must be loaded and enabled in HomeSeer. The
plug‐in may be obtained from the HomeSeer updater. Once enabled, the plug‐in will start listening for connections
on its default port of 10200. This port number can be changed by editing the plugin's INI file. Here is a list of the
various settings that can be changed in the file. To change or add these settings, edit the file hspi_HSTouch.ini. The
file is located in the HomeSeer config folder.

After changing any of these settings, you will need to restart HomeSeer before the change takes affect.

The first line of the file must start with:

[Settings]

Options available are:

Debug=1
Enables Debug mode and causes the HSTouch server to log more information about what it is doing

PortNumber=###
Enter the port number you want the server to listen on. The default is 10200. If you change this, you will
need to change the port number in the settings for the designer and the client application.

RSSUpdateInterval=##
Enter the number of minutes that the server waits before checking for a change in any RSS feed data. The
default is 10 minutes. Be careful setting this number to small as some services may ban you from accessing
their feed if you connect to their server too frequently.

See also
Command Line Options
Controlling Clients from HomeSeer
Customizing the Application for Installers
Date Time Functions
Replacement Variables

HSTouch

95

Chapter 6 Advanced Functions

Speaking Text To Speech ﴾TTS﴿
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Home > Mobile Clients

Mobile Clients
This opening paragraph should describe the feature that you are documenting. Explain how it is
commonly used and what the benefits are. For example: The Widget Master email link allows you to easily
send information about each widget to various departments within your company. Often, the feature that
you are documenting can be best explained by walking the reader through step by step. Use screenshots
to illustrate the steps where possible.
1. Start the application by…
2. On the startup screen, click the…
3.

See also
Welcome
Getting Started
Working with Projects
Tutorials
Dynamic Screens
Advanced Functions
Designer Properties
Credits

Home > Mobile Clients > Working with Android

Working with Android
The HSTouch client for Android devices is available from the Android Market, or the APK package file may be
downloaded from our website, downloads page. By default, the client will connect to our demo server at
demo.homeseer.com so the client can be tested. The client includes a few different configurations, choose the one
that looks best on your device. The configurations will automatically scale to your screen size. There is one for use
on phones ﴾portrait mode﴿ and one for devices that are to be used in landscape mode.
The client supports up to 3 server connections. Each connection can have it's own IP address and configuration
file. This allows you connect to 3 different HomeSeer servers, such as you main home and a vacation home. Use
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the settings to set up your server host name or IP address.
On the default configuration, the pass code for the Locks screen is "1234".
Fonts
The only fonts available for Android are the Droid fonts. The Designer installer will install these fonts.

See also
Working with IOS devices ﴾iPhone/iPod/iPad﴿

Home > Mobile Clients > Working with IOS devices ﴾iPhone/iPod/iPad﴿

Working with IOS devices ﴾iPhone/iPod/iPad﴿
The HSTouch client for the iPhone/iPod Touch/iPad is available from the Apple App Store. There are 2 applications
in the store, one for the iPhone/iPod and one for the iPad. These may be combined into one universal application
in the future. Install the one you need for your platform, there is no charge for the application. The licensing for
these applications is done through the HSTouch server plug‐in. Make sure this plug‐in is installed and enabled in
HomeSeer. If you own HS3 PRO, the license is included. For HS3 you will need to purchase HSTouch. If you are not
going to use the Designer, non PRO editions of HS3 will run as HSTouch Lite and allow you to use the default
projects that are included with the HSTouch clients.
When the iPhone is started, a default configuration is launched and it will connect to the HomeSeer demo server
at demo.homeseer.com. You can use this configuration to check your connection. To connect to your own system,
change the server setting in your iPhone Settings screen. Make sure you leave the port to 10200. You will need to
forward this port on your router if you intend on connecting remotely.

Rotation Support
This allows you to view the device in portrait or landscape mode. To support this you create 2 screens for each
screen you want to allow rotation for. One sceen will display in portrait view and the other in landscape view. To
create a configuration that supports rotation, do the following:

1. Start the designer and create a new project or open an existing project.
2. Select from Tools menu "Project Defaults" to bring up the project defaults dialog as shown:
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3. For the Orientation select "Both". Make sure the Type option is set to the proper device, either iPhone or
iPad.
4. The Width and Height options should be automatically set to the portrait size of your screen.
5. To support rotation you will need to create 2 screens for each screen you want to display. Click on one of
your screens to display the screen properties as shown:
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6. There are 2 properties you need to set on each screen. If this is the portrait view, set the Orientation
property to Portrait.
7. Now create your landscape screen by right clicking in the title bar of your current screen and select Copy
This Screen. This will create an identical copy.
8. To make this new screen a landscape view, click on the title bar to select the screen so the properties
appear, then change the Width and Height properties by reversing the values as shown. Also, change the
Orientation property to Landscape if it's not already set. It is a good idea to change the name of this screen
to the same name as your portrait screen but add a "‐L" to the name so you know which screen it is linked
to. Now the LinkedScreen property needs to be set to the Portrait screen. This allows the HSTouch client to
know which screen to display when the screen is rotated. When you set this property on either the portrait
or landscape screen, it is automatically set on the other screen. So your portrait screen should be all set at
this point.
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9. The landscape screen can now be modified by moving elements to their proper position, re‐size, etc.

List Boxes

List boxes that are linked to the device selector, events selector, or music selector, need some special attention when
screens are rotated. These elements hold status as to their current view. When rotating the screen it is desirable
that the list boxes on both screens stay in sync ﴾display the same view﴿. To make this happen, click on the list box
on one of your views to display it's properties. The only property you need to deal with is the LinkedList property.
Set this to the list on the other screen that should stay in sync with this list. When you set it on one screen, it will
automatically be set on the other screen so both lists are linked together. This will ensure that the view is the same
when the screen is rotated.

Fixed Orientation

If rotation support is not desired, select the desired view from the Tools menu Project Defaults dialog. The view can
be fixed to portrait or landscape. When creating landscape screens make sure you adjust the Width and Height
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properties to represent the landscape view.

Battery Level

The battery level on these devices can be displayed on any of your screens. See the $BATTERY replacement
variable for more information.

See also
Working with Android
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Home > Designer Properties

Designer Properties

See also
Welcome
Getting Started
Working with Projects
Tutorials
Dynamic Screens
Advanced Functions
Mobile Clients
Credits

Home > Designer Properties > Properties Pane

Properties Pane
All element properties may be edited by selecting the element and adjusting the element properties in the
Properties Pane. The properties displayed in the Properties Pane are always specific to the element ﴾or group of
elements﴿ selected.

ACTIONS
Property

Description

ActionsWhenPressed

Sets the actions performed when element is pressed.

ActionsWhenReleased

Sets the actions performed when element is released.

ActionsWhenSelectionChanged

Sets the actions performed when selection changes.
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HonorAllReleases

If TRUE then all element release actions are executed
even if a user slid their finger off an element then
released. Enable this for cases where the press action
starts an action ﴾such as raising the volume﴿ and the
release stops the action. You want the release action to
always be executed even if the selection is no longer on
the element. When False, the release actions are not
executed when a user selects an element but changes
their mind and slides their finger off the element. This
property is only available for the label element ﴾buttons
or text elements﴿.

IgnorePresses

Set to 'true' to ignore presses on this element. Use for
graphics, text and labels.

APPEARANCE
BorderStyle

Sets the border style for this element.

ColorNormal

Sets the normal background color for this element.

ColorPressed

Sets the pressed background color for this element.

FontColorNormal

Sets the normal font color for this element.

FontColorPressed

Sets the pressed font color for this element.

FontNormal

Sets the normal font for this element.

FontPressed

Sets the pressed font for this element.

ImageBackground

Sets the background image for this screen.

ImageFormat

Sets the image format for this element. 'Normal' displays
the image at its original size and proportion; 'Stretched'
automatically resizes the image to fit the element.

ImageNormal

Sets the normal image for this element ﴾from local PC or
network﴿.

ImagePressed

Sets the pressed image for this element ﴾from local PC
or network﴿.

ImageURLNormal

Sets the normal image for this element ﴾from internet
URL﴿.

ImageURLPressed

Sets the pressed image for this element ﴾from internet
URL﴿.

PointerImage

Sets the pointer image for this element. ﴾slider element
only﴿
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Text

Sets the text label for this element. HomeSeer script
statements can also be entered here to display specific
information. For example, the HomeSeer HSM100 motion
sensor holds the temperature in the device value
property. The temperature needs to be divided by 10 to
get the actual temperature. If the temperature was 72.5
degrees, the value would be held as 725. To get
HSTouch to display the proper temperature, use the
HomeSeer script command "hs.DeviceValue﴾DEVICE﴿". If
the HSM100 temperature device had a code of "Q1", just
enter this in the HSTouch text property:
[$SCRIPT=&hs.DeviceValue﴾"Q1"﴿/10]
Note that script commands can only be added to the
Text property of the Label element. See the HomeSeer
scripting document for more information on all
HomeSeer scripting commands.

TextAlignment

Sets the text alignment for this element.

IDENTIFICATION
Name

Sets the name for this element.

LOCATION/SIZE
Left

Sets the distance ﴾in pixels﴿ from the left edge of the
screen to this element.

Top

Sets the distance ﴾in pixels﴿ from the top edge of the
screen to this element.

Width

Sets the width ﴾in pixels﴿ for this element.

Height

Sets the height ﴾in pixels﴿ for this element.

ZOrder

Sets the display order for this element to 'Front' or 'Back'.

SETTINGS

Marquee

Set to TRUE to have text scroll from left to right. The text
will only scroll if it does not fit in the space allocated to it.
When TRUE the text will not wrap, even if there is space
to wrap the text.

MarqueeIncrement

When Marquee is TRUE, this is the number of pixels that
the text will scroll when the MarqueeSpeed time has
expired. Use with MarqueeSpeed to obtain the desired
text scroll speed.

MarqueeSpeed

The update speed of the text in milliseconds. Use with
MarqueeIncrement to obtain the desired text scroll
speed.
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OffsetMax

Sets the offset ﴾in pixels﴿ from the top ﴾or left﴿ edge of
the slider to the maximum position of the pointer image.
Used for limiting the travel of the pointer image within
the slider.

OffsetMin

Sets the offset ﴾in pixels﴿ from the bottom ﴾or right﴿ edge
of the slider to the minimum position of the pointer
image. Used for limiting the travel of the pointer image
within the slider.

Orientation

Sets the element's orientation to 'Horizontal' or 'Vertical'.
Used for progress bars and sliders.

SmallChange

Used when the slider is non graphical.

TickFrequency

How many tick marks are displayed when the slider is
non graphical.

TickStyle

The style of the tick marks when the slider is non
graphical.

TrackRealtime

If 'True', sets the slider to function as a real time control. If
'False', passes slider values only when pointer is released.

ValueInitial

Sets the initial value for this element.

ValueInvert

Set to 'True' to invert the values for this element.

ValueMax

Sets the maximum value returned by this element. This
value is set automatically if associated with specific items
of known value.

ValueMin

Sets the minimum value returned by this element. This
value is set automatically if associated with specific items
of known value.

LockToBackground

For an image element, the graphic may be locked to the
background. Once this is set, the image may only be
moved using the arrow keys. This setting causes the
client to draw this image on the background. This
speeds up rendering of the background and ensures
that any transparent elements placed on this graphic are
drawn properly. If this is enabled, the "Ignore Presses"
property is always treated as TRUE and the element
cannot detect presses.

STATUS/DEVICE ASSOCIATIONS
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StatusColors

If an element has a status text association set ﴾using
StatusTracking...﴿ then this property will be available. Use
this to assign a different background color, font color, or
alternate text to an element. For example, you can assign
a different background color to the element if a
HomeSeer device is ON or OFF or DIM, or change the
displayed text to "Light On" when the devices's status is
set to ON.

StatusImages

If an element has a status graphic association set ﴾using
StatusTracking...﴿ then this property will be available. Use
this to assign graphics to various status values. For
example, you can assign different graphics to the
element if a HomeSeer device is ON or OFF or DIM.

StatusTracking

Sets the association of an element to a HomeSeer
device, thermostat, music player or RSS data field for
status and control. ﴾Available only on slider elements﴿

StatusTrackingNormal

Sets the association of a button element ﴾in its normal
state﴿ to the status of a HomeSeer device, thermostat,
music player or RSS data field.

StatusTrackingPressed

Sets the association of a button element ﴾in its pressed
state﴿ to the status of a HomeSeer device, thermostat,
music player or RSS data field.

WEB

AllowNavigation

If the Text property is a URL, a browser is loaded into the
element. Set this property to TRUE if you would like to
allow the user to browse using any links that are
displayed on the page. If FALSE, browsing is not allowed
and the links are not active. On CE this property is
ignored. ﴾only available with the Text or Label element, or
buttons﴿

IsHTML

If set to TRUE, the element will display any text in the
Text property as HTML. This allows you to use HTML
formatting for your displayed text. ﴾only available with
the Text or Label element, or buttons﴿

See also
Properties Pane for Screens
Action Types
Element Types
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Home > Designer Properties > Properties Pane for Screens

Properties Pane for Screens
When you click on the background of a screen ﴾or click in the title bar﴿ the properties for the screen appear in the
properties pane. Here are the descriptions for all available properties:

APPEARANCE
ColorBackground

Sets the background color for this screen.

ImageBackground

Sets the background image for this screen.

ImageFormat

Sets the image format for this element. 'Normal' displays
the image at its original size and proportion; 'Stretched'
automatically resizes the image to fit the element.

IDENTIFICATION

ScreenTitle

The name of this screen. Will Be displayed in the title bar
of the screen if the title bar is enabled in the project
defaults. This is also used to reference this screen in the
element actions.

SETTINGS
Width

The width of the screen in pixels.

Height

The height of the screen in pixels.

Top

Where the top edge of the screen is located when its
initially displayed on the screen.

Left

Where the left edge of the screen is located when its
initially displayed on the screen.

AnimateStyle

On Windows platforms, screens may be displayed using
animation such as slide right, up or down, roll in, or fade
in and out. Select the style you would like applied to the
screen when it is displayed or hidden.

AnimateDelay

When using an animation style, this is the speed in which
the animation takes place. The value is in milliseconds.
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IsMain

Passcode

When set to TRUE this screen is a main screen and is
displayed when the HSTouch client is started. You can
have multiple main screens. For example, a small screen
across the top may be used as a menu bar and would
have the IsMain set to TRUE so its always displayed when
the system starts.
Enter a numeric passcode to protect this screen. If
nothing is entered here, the screen will be displayed
without prompting the user for a passcode. If a passcode
is entered, a small numeric keypad will be displayed
allowing the user to enter the passcode. The user must
enter the correct passcode in order for the desired
screen to display. Use this feature to procted screens that
may disarm a security panel. When this property is first
set, the HSTouch Designer will automatically create a
passcode screen for you using the template named
Passcode.xml in the Custom pallette. It will look for the
template under the currently selected skin. You may edit
this screen after its added to the project to suit your
needs.
See this HowTo for more details.

DeviceTypes

If set, this screen will be used as a dedicated control
screen for a specific device. When a user selects a
device from the device list selector, a screen with a
device type matching the target device is located and
displayed. See Working with Screens for more
information. List one device type per line.

See also
Properties Pane
Action Types
Element Types

Home > Designer Properties > Action Types

Action Types
Here are the available action types and their uses.
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CONTROLS
Name

Description

Adjust a control's level down

Use to adjusts a control's level down. You select the
control and the value to adjust down.

Adjust a control's level up

Use to adjusts a control's level up. You select the control
and the value to adjust up.

Append text to a text box control

Use to enter data into a text box control.

Apply a display filter

Use to apply a display filter to a list box or to the music
selector. Use CHAR* to filter on the first character such as
"F*". Use CHAR‐CHAR to display a range such as all text
that starts with A through F, use: A‐F

Clear a text box control

Use to clear a text box control.

De‐select / De‐emphasize a
control

Use to change a control from a selected or emphasized
﴾pressed﴿ state to a de‐selected or de‐emphasized
﴾unpressed﴿ state.

Disable a control

Use to disable a control.

Enable a control

Use to enable a control.

Hide a control

Use to hide a control

Select / Emphasize a control

Use to change a control from a de‐selected or de‐
emphasized ﴾unpressed﴿ stat to a selected or emphasized
﴾pressed﴿ state.

Simulate a press and release on
another control

Use to simulate a press and release on another control.
Useful if you wish to activate more than one control with
just one action.

Simulate a press on another
control

Use to simulate a press on another control. Useful if you
wish to activate more than one control with just one
action.

Simulate a release on another
control

Use to simulate a release on another control. Useful if
you wish to activate more than one control with just one
action.

Trigger the 'Text Changed'
actions on a text box control

Use to trigger the 'text changed' actions on a text box,
even if the text itself hasn't changed.

Unhide a control

Use to unhide a control.

Set and Elements Image

Use to change the image that is displayed in an image
element. The action parameter is the filename to the new
image.
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Set an Elements URL

Use to change the URL an element is using to display
HTML content. This will cause the element to display the
web page that the URL is pointing to.

Increment RSS feed row index to
display

Select the element that holds the RSS data that you want
to change. This action will increment the index of the row
that is currently being displayed. Many RSS feeds have
multiple rows of data and this action will allow you to
display the next set of data in the RSS data. Use it to
display the next news item from a news feed for example.

Set RSS Feed row index to
display

When an element displays RSS data, one of the
properties is the RSS table row index. Normally, each row
will display different content, for example a news feed
may contain a different news article for each row index.
The row index can be assigned at design time, but its not
always known how many items are in the RSS table. By
assigning this action to a button, you can alter which row
is displayed in the view. This allows for one large view of
HTML content and then a row of buttons to change the
row index and display more information.

Set an Elements text property

Use to set the text property of a text or button element.
The text property is the displayed text on the element.

HOMESEER
Control a HomeSeer device

Use to control a HomeSeer device ﴾from any HomeSeer
automation system﴿.

Run a HomeSeer script with
values from control﴾s﴿

Use to run a HomeSeer script based on values entered.
Useful for working with security codes and passwords.

Trigger a HomeSeer event

Use to trigger a specific HomeSeer event.

MISC
Pause / Wait for up to 2 minutes

Use to introduce a pause into any multiple action
sequence.

Play a WAV sound file

Use to play a WAV sound file.

Exit Application

Causes the HSTouch client to exit.

Launch Application

Will launch the application specified. The full path to the
application may be required. On Android, the name of
the application, on IOS use a URL scheme that is
published by the app to be launched.

Minimize Client

Minimizes the HSTouch client application to the task bar.
﴾not available on CE﴿

MUSIC
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Music Selector Back

Use to return the music selector to its most previous
state. Works like a 'back' button in a browser.

Mute

Use to mute music.

Pause

Use to pause music.

Pause if Playing

Use to pause music if playing.

Play

Use to play music.

Play if Paused

Use to return music from pause to play.

Play selected music

Use to play selected music.

Set Music Selector display

Use to set music selector to display attributes from the
music API including Genres, Artists, Albums, Playlists and
Tracks.

Set Repeat All Tracks

Use to set 'Repeat All Tracks' on.

Set Repeat Off

Use to set 'Repeat All Tracks' or 'Repeat One Track' off.

Set Repeat One Track

Use to set 'Repeat One Track' on.

Set Shuffle to Ordered Play

Use to change from shuffled play to ordered play.

Set to play in Sorted Order

Use to change from default order play to alpha‐sorted
order play.

Set to Shuffled Play

Use to change from ordered play to shuffled play.

Skip to the Next Track

Use to skip to the next track.

Skip to the Previous Track

Use to skip to the previous track.

Skip to the Selected Track

Use to skip to the selected track.

Stop Play

Use to stop play.

UnMute

Use to unmute music.

Volume Down

Use to change volume down.

Volume Up

Use to change volume up.

Add Selected Track to Playlist

Adds the track that is selected in a list box to the currently
active play list.

SCREEN
Close a screen

Use to close a specific screen.

Show another screen by itself

Use to show another screen by itself.

Show another screen on top of
the current screen

Use to show another screen on top of the current screen.
Useful for 'pop‐up' effects.
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THERMOSTATS
Enable or Disable Hold

Sets the thermostat Hold mode

Next Fan Mode

Cycles the Fan between On and Auto.

Next Operating Mode

Cycles the mode on the thermostat. The mode will be set
to the next mode in the order: Off, Heat, Cool, Auto, then
back to Off. It does not cycle through the AUX mode as
most thermostats do not support this mode. Use a
separate button if you need to set the AUX mode.

Raise or Lower the Cool Set
point

Raises or lowers the Cool set point by the value given.
Values are positive for raising the setpoint and negative
for lowering the set point.

Raise or Lower the Heat Set
point

Raises or lowers the Heat set point by the value given.
Values are positive for raising the setpoint and negative
for lowering the set point.

Raise or Lower the Set point

Raises or lowers the set point using the current mode. If
the current mode is Heating, then the heat set point is
modified, if the current mode is Cooling, then the Cool
set point is modified. Has no affect for Aux, Off, or Auto
modes.

Set the Cool Set point

Sets the Cooling set point to the value given.

Set the Fan Mode

Sets the Fan to On or Auto.

Set the Heat Set point

Sets the Heating set point to the value given.

Set the Mode

Sets the current operating mode, Off, Heat, Cool, Auto, or
Aux.

See also
Properties Pane
Properties Pane for Screens
Element Types

Home > Designer Properties > Element Types

Element Types
All elements are added to the Design Area with a drag/drop operation from the Elements Palette. HSTouch includes
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the following element types:

Graphic Button: A graphic button is a control element with pre‐defined graphics that may trigger actions when
pressed or released. Graphic buttons may be accessed from the 'Buttons' tab of the Elements Palette.

Slider: A slider is a control element with pre‐defined graphics that's designed to change the value of a device or
other control. Sliders may be accessed from the 'Sliders' tab of the Elements Palette.

Music Groups: Music Groups are custom control groups that include music control elements. Music Groups may
be accessed from the 'Music' tab of the Elements Palette.

Thermostat Groups: Thermostat Groups are custom control groups that include thermostat control elements.
Thermostat Groups may be accessed from the 'Thermostats' tab of the Elements Palette.

Text: Text is a design element that's typically used to add a label or description to a screen. Text elements may be
accessed from the 'Other' tab of the Elements Palette.

Button: A button is a control element without pre‐defined graphics that may trigger actions when pressed or
released. Button elements may be accessed from the 'Other' tab of the Elements Palette.

Image: An image is a design element used for displaying a new photo or other graphic. Once an image is
created, it will be added to the 'Graphics' elements ﴾defined below﴿. Image elements may be accessed from the
'Other' tab of the Elements Palette.

Group Box: A group box is an element used to create custom groups. A custom group is a collection of control
and/or design elements that work together in some fashion. Group box elements may be accessed from the
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'Other' tab of the Elements Palette.

Status Bar/Gauge: A status bar is a design element that's used to display the status of a device or other control.
Status bars may be accessed from the 'Other' tab of the Elements Palette. The format may be either a
horizontal/vertical bar, or a round gauge that uses a needle to indicate a value. When creating a gauge, set the
"Style" property to "Gauge", set the background graphic for the gauge and the needle graphic. Sample gauges are
located in the "My Documents\hstouch\Skins\Default\Gauges" folder. Set the max/min angle so the needle aligns
properly with the max and min value. You can set the value property in order to determine the proper angle. The
default gauge uses a min/max of ‐148 and 148 degrees. Set the min/max value that the gauge will display. The
gauge can be associated with any HomeSeer device in order to display its value, such as a power monitor.

Text Box: A text box is a control element that allows text entry for use with other control or design elements. Text
box elements may be accessed from the 'Other' tab of the Elements Palette.

Drop List: A drop list is a control element that allows a selection to be made from a pre‐defined list. Drop list
elements may be accessed from the 'Other' tab of the Elements Palette.

List Box: A list box is a control element that allows a selection to be made from a pre‐defined list. List Box list
elements may be accessed from the 'Other' tab of the Elements Palette. List boxes hold 2 items per entry, a name
and a value. You can enter both of these manually from the properties pane, or you can associate a list box with a
HomeSeer device. If the device has name/value pairs associated with it ﴾you can tell if it does if it has a drop list of
items on the HomeSeer status page﴿, then the names and values will populate the list box automatically. When you
select an item from the list, the device in HomeSeer automatically gets set to the new value. This may not always
be desirable. At times you may want to display a list of items, but not affect the actual HomeSeer device. In these
cases, check the box "Do not control associated device when element is selected". This will allow the user to make
a selection, but the device in HomeSeer will not be changed. You can still send the selection to HomeSeer if
needed so it can be processed by a script. To do this, add a new button to your screen and set the action to run a
HomeSeer script. Select the script then set the parameter 1 to the list box you are using. When a user clicks on a
selection, the selection is sent as parameter 1 to the script in HomeSeer. The parameter is formatted with both the
selection name and its value, seperated with a CHR﴾7﴿ character. In HomeSeer, you can accept this parameter and
process as needed. Here is a sample HomeSeer script named "process_list.txt":

sub main﴾parm﴿

dim sel_name
dim sel_value
dim parts

parts = split﴾parm,chr﴾7﴿﴿
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sel_name = parts﴾0﴿
sel_value = parts﴾1﴿

hs.writelog "info","name=" & sel_name & " value=" & sel_value
' process the name and parts here

end sub

Custom Groups: A custom group is a pre‐defined collection of control and/or design elements that work
together in some fashion. Custom group elements may be accessed from the 'Custom' tab of the Elements Palette.

Graphics: A graphic is a design element consisting of a pre‐defined image ﴾defined above﴿. Graphic elements may
be accessed from the 'Graphics' tab of the Elements Palette.

Backgrounds: A background is a design element with a pre‐defined graphic. Backgrounds will always occupy the
bottom layer of the design screen and serve as backdrops for all of the other elements. Background elements may
be accessed from the 'Background [height x width]' tabs of the Elements Palette.

See also
Properties Pane
Properties Pane for Screens
Action Types
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Home > Credits

Credits
Portions of the iPhone client use regexkit and are Copyright ﴾c﴿ 2008‐2009, John Engelhart

See also
Welcome
Getting Started
Working with Projects
Tutorials
Dynamic Screens
Advanced Functions
Mobile Clients
Designer Properties
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